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2. Click I nstall.
3. Then click Next.
4. Choose an installation option:

• Typical Installation—Copies all the program files to your system, but
leaves the larger endgame databases and the audio files on the CD for you
to access as needed.

• Full installation—Copies all CHESSMASTER 9000 components to your
hard drive, provided that you have sufficient space on your drive.

5. Click Nextand specify where you want to install CHESSMASTER 9000. The
default installation path is C:\Program Files\Chessmaster 9000. Click Browse
if you wish to specify a different path.

6. Click Nextagain to begin the installation.
7 . When the installati on is complete, select Re s t a rt Wi n d ow s, and then click Ne x t.
8. Click Finish and Restart WindowsNow.

§ Starting CHESSMASTER 9000
Insert Disc 1into your CD-ROM drive. You should
see the CHESSMASTER 9000 Welcome screen.
Then, choose from the following options:
• Click Run to start CHESSMASTER 9000.
• Select the Uninstall option from the Windows

program menu if you wish to remove
CHESSMASTER 9000 from your system.

• Click Cancelto exit CHESSMASTER 9000. If Disc 1is currently in your
CD-ROM drive, or if you have Autoplay turned off on your CD-ROM drive,
you can start CHESSMASTER 9000 by doing the following: 
Choose Programs>Chessmaster 9000>Chessmaster 9000from the
Windows Start menu.

• When you start CHESSMASTER 9000, the Introduction video plays. You
can watch the video or skip it by pressing any key or clicking the mouse.
When the video stops, the Player Login screen appears.

§ To begin using CHESSMASTER 9000, you must log in as a player:
1. Click New Player and the Create New Player 

screen appears.
2. The first time you play CHESSMASTER 9000,

you will be allowed to set the level of play. If you
know your chess rating, for example, you can
type it in. This will determine the level of
opponents you face.

3. In the Player Name box, type the name you wish to use.

5Introduction

INTRODUCTION
Congratulations! You’ve purchased the latest version
of the world’s best-selling chess program. Whether
you’re new to chess programs, or a
CHESSMASTER® veteran, you’ll find that
CHESSMASTER® 9000 is the most
comprehensive chess software available anywhere.
Now, there are many more ways for you to improve
and enjoy chess:
• New chess sets and boards, including over 60 new True-3D chessboards and 

piece sets
• More ways to play chess, including a new QuickStart! mode
• New Chess courses and tutorials only available in CHESSMASTER 9000
• New analysis function that lets you select the level of advice you need
• Over 150 opponents, from beginner to Grandmaster level
• New functions for advanced players

If you are new to CHESSMASTER, or simply want to jump right in and
start playing, look throughout the manual for this symbol: §, which will
give you the basics you need to begin. Later, you can learn more about the
advanced features of CHESSMASTER 9000.

§ QuickStart!
If you are familiar with previous versions of CHESSMASTER, and you want to
jump right in and play chess, go to the Game Room and click on the QuickStart!
button. CHESSMASTER 9000 will set up a game for you, based on your rating
choice when you created your user.

§ Minimum System Requirements
CHESSMASTER 9000 does not officially support Windows® 95 or 2000
Pentium II 450 or AMD K6-3 500 
Windows 98/ME 64 MB RAM (128 MB RAM recommended) 

Windows XP 128 MB RAM (256 MB RAM recommended)
Di rectX8.1-compatible v ideo card (Includes support for high-end 3D v ideo card s )
300 MB hard drive space
Windows-compatible mouse
Internet connection for play on Ubi.com (minimum 56k modem or broadband)

§ Installing CHESSMASTER 9000
You must use the setup program to install CHESSMASTER 9000. You cannot
install it by copying the software from the CD to your hard drive.
1. Insert Disc 1 in your CD-ROM drive. If you’re installing CHESSMASTER

9000 for the first time, the CHESSMASTER 9000 Welcome screen appears.

Introduction4
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needs and tastes. Depending on which room you’re in, setting up the
environment can involve one or more of the following:

• Designing the layout of your playing area.
This includes selecting a chess set, defining its
position, and displaying one or more of the
CHESSMASTER windows.

• Setting up sounds, narrated features, and
w i n d ow and CMLive effects. For example, yo u
can activate sound narration, so that you can
listen to CHESSMASTER’s advice while yo u’re
playing a game. You can tell CHESSMASTER
to notify you when someone from Ub i . c o m
logs on, sends you a message, or challenges you to a game.

• Configuring your chessboard, which includes specifying certain settings, such
as turning the board lights on or off, determining the speed at which the chess
pieces move, deciding whether you want CHESSMASTER to let you know
the openings that you and your opponent are using, and so on.

• Specifying the type of chess notation you want to use. Chess notation refers to
the method of recording the moves on the chessboard.

How to Design Your Playing Area
The playing area consists of the chess set, the chessboard, and the
CHESSM ASTER 9000 windows that appear in a given room. For example, in the
Game Room, you might want a True-3D Blue Marble chessboard wi th Isle of
L ewis pieces, with the Pl a yer Profile, Captured Pieces, and Game Status w indow s
open. Howe ve r, in the Kids’ Room, you might want a simple 2D Kids’ chessboard
with Kids’ Clay pieces and the Sh o rtcuts and Chess Coach windows open.
So, you can design the layout of the playing area with any or all of the
CHESSMASTER 9000 features you want. Or, you can use one of the pre-
defined layouts that CHESSMASTER provides. If you choose to design your
own custom layout, you can save it to a file, and then use it again later.

§ To design the layout of the playing area:
1. Select Preferences from the menu bar of any room.
2. Then choose Chess Set. The Select Chess Pieces & Board screen appears.
3. Select the chessboard you want from the top and the pieces from the bottom,

and then click OK. CHESSMASTER displays the chess set you selected.
4. Click anywhere on the border (or frame) of the chessboard, and then drag it to

the location you want.

5. If you have chosen a True-3D chess set, you can resize the 3D chessboard, 
zooming in and out with the wheel on your mouse. 

6. From the Windows menu, select the windows you want to display in the
playing area. A chess piece symbol next to the menu option indicates the
corresponding window is open.

7Defining Your Room Environment

4. Click Create. The CHESSMASTER 9000 lobby appears with seven icons, or
“doors” that lead you into the seven CHESSMASTER rooms — the Library,
Classroom, Tournament Hall, Game Room, Database Room, Kids’ R oom, and
CMLiv e Room. 

5. To delete a player, simply select the player you want to delete from the list, and
click Delete.

Note: When you create a playe r, CHESSMA STER 9000 adds the name to the
Pl a yer Login list. So, the next time you start CHESSM ASTER 9000, you can simply
select your name, and then click Login. Using the above steps, you can add as many
p l a yers as you wish.

Viewing Player Information
CHESSMASTER 9000 keeps a player profile for each player you add on the
Player Login screen, tracking the wins, losses, draws, overall ratings, number of
tutorials completed, and several other statistics.
To view the statistics for a given player:

1 .From the Pl a yer Login l ist, select the player whose information you want
to view, and then click View Pl a ye r. The Pl a yer Profile for  the selected
p l a yer appears.

2. Click the appropriate tab to view the statistics you want.

Note: When you’re in a given room, you can view the profile of the current player.
From the Game Room, Classroom, Tournament Hall, Library, and CMLive, choose
Player Statistics from the Windows menu. From the Kids’ Room, choose Player
Progress from the Windows menu.

§ Puzzle of the Day
Be f o re you log in to CHESSM ASTER, you can challenge yourself r ight 
away by trying to solve this puzzle, which changes eve ry time you start
CH ESSMAST ER 9000.
To use the Puzzle of the Day:
1. Start CHESSMASTER 9000 to display the Player Login screen.
2. Read the tip below the puzzle, and then attempt to solve it. CHESSMASTER

9000 lets you know if the move you make is right or wrong.
3. If you can’t figure it out, simply click I Give Up, and CHESSMASTER 9000

will highlight the correct move for you. 

4. If you wish, you can ignore the puzzle and simply log in to CHESSMASTER.

DEFINING YOUR ROOM ENVIRONMENT
The many powerful features of CHESSMASTER 9000 are organized into seven
different rooms: The Library, Classroom, Tournament Hall, Game Room,
Database Room, Kids’ Room, and CMLive. Each CHESSMASTER room
provides a set of features that lets you design the room environment to suit your

Defining Your Room Environment6
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Shortcuts window—Lets you quickly access commonly used features in the
corresponding room. 

Game Status window—Displays names of players and their ratings, elapsed time
for each player, the Move List (in whatever notation you’ve selected), and V CR
buttons that let you scroll through each move in the game. This window is not
available in the Classroom.

Annotation window—Lets you see CHESSMASTER’s comments and analysis
of your game:

Player Tab—Here, you may enter comments and analytical information on the
moves you make during a game. Simply click the Edit button, type the
information you want in the edit box, and then click OK.

Auto Annotation Ta b— To have CHESSMA STER analyze a game yo u’ve just
p l a ye d :
1. Select Game Analysisfrom the Mentor menu. 
2. Click Play on the Auto Annotation tab.
3. Then listen to CHESSMASTER provide commentary on the current game. 
4. Click Pauseto interrupt the analysis at any time, and click Play again to

resume the analysis. 

5. Click Stop to halt the analysis and to rewind the analysis to the beginning.
6. You can also load a saved game and analyze it the same way.

Analysis Tab—Provides analysis on the current game situation, including a
numerical score and the best line of moves. Use the V CRbuttons on the Game
Status window to scroll through and review the analysis.

Note: Because you use the Annotation window to enhance your playing skills and to
study existing games, it is accessible only in the Game Room and the Library.

Captured Pieces window—Displays the captured pieces on both sides as the
game progresses. You can resize the window as necessary to show all the captured
pieces. This window is not available in either the Classroom or Database Room.

Player Statistics window—Displays a profile on the player currently logged in to
CHESSMASTER 9000. It also keeps track of the wins, losses, draws, overall
rating, number of tutorials completed, and several other statistics.

Pl a yer Pro g ress window—Like the Pl a yer Statistics window, but for the
K i d s’  Ro o m .

Note: CHESSMASTER 9000 keeps separate stats for your online play. These stats
can be accessed in the CMLive room, and are the stats used when you are competing
against other CHESSMASTER owners on Ubi.com.

9Defining Your Room Environment

7. CHESSMASTER saves the current layout of your playing area until you
customize it again or replace it by opening an existing layout.

§ Opening and saving playing area layouts
1. From the Preferences menu, choose Layouts. 
2. Click the Savetab, and then specify where you want to save the layout. The

default path is C:\Program Files\Chessmaster 9000\Layouts.

3. In the File Name box, type a name for the layout, and then click Save.
CHESSMASTER automatically appends the menu extension to all layout files.

§ To open an existing layout:
1. From the Preferences menu, choose Layouts, and then choose Load.

2. Open the folder that contains the layout you want. The default path is
C:\Program Files\Chessmaster 9000\Layouts.

3. Double-click the layout you want, or select the layout and click Load.
CHESSMASTER opens the playing area layout you selected.

Note: At any time, you may restore the default layouts by selecting Restore Defaults
from the Preferences pull-down menu.

§ Selecting a Chess Set
Over the centuries, the game of chess has
continued to inspire artists around the world.
CHESSMASTER 9000 provides you with the
widest variety of chess sets on the market,
including over 60 new True-3D chess sets and
boards. When you choose Chess Set from the
Preferences menu in CHESSMASTER 9000,
the program automatically chooses the matching
board for you, and vice versa. If you want to try out different boards and pieces
together, simply turn the Match Boards and Pieces option off.

§ Using the CHESSMASTER Windows
All the CHESSMASTER rooms (except the Database Room) provide seve r a l
visual aids that you can use while you play, practice, or learn chess. You can
access these visual aids (also called “w i n d ow s” ) by selecting Wi n d ows from the
menu bar of any ro o m .

This section describes the available CHESSMASTER windows. Note that some
of the windows are not accessible in certain rooms. For example, the Annotation
window, which contains comments and analytical information on the current
game, is not available in the Tournament Hall, because when you’re playing a
tournament, you’re not supposed to have access to such information.

Note: Windows that are specific to a given room are described in their respective
chapters later in this User’s Guide. For example, the Chat window and Online
Information window, which are accessible only in the CMLiv e Room, are described in
“The CMLive Room.”

Defining Your Room Environment8
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selected, the default “drag and drop” method will be used.
In addition, there are a number of 3D effects settings that vary according to your
type of video card and what 3D effects, if any, it supports.

Flipping Your Chessboard
At any time, you can flip the chessboard to see the board from yo u r
o p p o n e n t’s perspective, by selecting Fl ip Board from the Pre f e rences menu or
by pressing C t r l - B. 

Note: If you are playing with a True-3D board, you can rotate the board freely using
the mouse and keyboard.

§ Using a True-3D Chessboard
1. From the chessboards available, select a True-

3D board or set.
2. If you wish to try out different 3D boards

and pieces together, simply turn the Match
Boards and Pieces option off.

3. You can resize any 3D chessboard by
zooming in and out with the wheel on your
mouse. 

4 .For  more fine control  over zooming, use
A l t - Mo u s e.

5. If you wish to rotate the 3D board, position your mouse near the center of the
board. Hold down Ctrl and move the mouse to rotate the 3D board from left
to right, and tilt it forward and back.

6 . You can flip the 3D board and pieces around wi th C t r l - B, just as you can a
2D board. 

7. You can also move the 3D board around with hotkeys. The F2 through F6
keys move the 3D board around in various preset positions. 

8 .The F 7, F 8, and F 9 keys are left for you to save your  own preset 3D
board positions .

9. You can also modify the 3D board by right-clicking on the board and selecting
from the menu.

11Defining Your Room Environment

§ Configuring Your Chessboard
1. From the Preferencesmenu, choose Board Settings.
2. There are three tabs that let you adjust your

chessboard:
a. Appearance

b. Function
c. 3D Settings

3. Use the check boxes and buttons to specify
the board settings you want.

4. Click OK to apply the selected settings to
your chessboard. You may turn the following
Board Settings options on and off:

Announce Check and Announce Op e n i n g s—
CH ESSMASTER announces when you are in check and what opening lines yo u
and your opponent are using. The re s p e c t i ve messages are displayed in the status
b a r, at the lower left of the room w indow. 

Board Coordinates—Determines whether your chessboard displays coordinates,
and how CHESSMASTER displays them. Normally, the horizontal rows are
labeled 1 through 8, and the vertical rows are labeled a through h. If you click
In-Square, CHESSMASTER displays the corresponding Rank & File coordinate
in each square, so you don’t have to figure them out on your own.

Board Turn Lights—Lights that appear on the right side of the chessboard
indicate whether it is White or Black’s turn to move. 

Highlight Move Squares—CHESSMASTER reiterates each move, by
highlighting the piece’s original square, and then the destination square. This
option is on by default. You may also choose to have CHESSMASTER draw an
arrow between the two movement squares.

Quick En t ry—Lets you move a chess piece by cl icking its destination square ,
rather than dragging and dropping i t. When Quick entry  is active, and you click a
piece that has exactly one legal move, that move is made. If you click a square to
which only one piece can move, that move is made. Quick En t ry is off by default.

Sliding Pieces—Refers to the animation speed at which your opponent’s pieces
move. The default speed is Fast, which causes your opponent’s pieces to move
across the board quickly. If you click Off , your opponent’s pieces snap to their
destination. If you click Slow, your opponent’s pieces slide slowly to their
destination squares.

Time Stamp Annotation—CHESSMASTER adds the elapsed time for each
move into the Player tab of the Annotation window. The time is taken from the
elapsed time indicated on the Game Statuswindow.

Two-Click Moves—Lets you move pieces by clicking once to pick up the piece,
and again to drop the piece on the destination square. If this checkbox is not
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§ Recording Moves with Algebraic Notation
Algebraic Notation is the most common method of recording moves in a chess
game, combining symbols for the piece and its destination square. Major pieces
are uppercase letters (K, Q, B, N, R), Pwans are rank and file, files are lowercase
letters “a” through “h”, and ranks are numbers 1 through 8. Here is an example:
Be5 is Bishop to file e, rank 5, and e5 is Pawn to file e, rank 5.
Algebraic notation records captures with an x (for example, Bxe5), check with a
plus sign (+), checkmate with a double plus sign (++) or #, castling Kingside with
a O-O, and castling Queenside with a O-O-O. To describe a move in algebraic
notation, first indicate the letter of the piece that is moving: K for a King, Q for
a Queen, R for a Rook, B for a Bishop, and N for a Knight. If you’re moving a
Pawn, indicate the file (a - h) and rank (1 - 8) of the piece’s destination square. 

When a move causes checkmate, this is indicated with a ++ at the end of the
move, such as, Rh7++. Checkmate can also be indicated with a number sign (#)
in CHESSMASTER 9000.
In addition to the standard Algebraic notation, CHESSMASTER 9000 also
provides Coordinate, Long Algebraic, Figurine Algebraic, Descriptive, and
International notation. Simply choose the type of notation you wish from
Notation in the Preferencesmenu. 

Note: If you are unfamiliar with chess notation, we strongly suggest that you use the
Tutorials in the Classroom to learn about the various methods of re c o rding chess games.

THE GAME ROOM
The CHESSMASTER 9000 Game Room gives you
an incredible range of tools to play and learn about
chess. It’s the place to play Unratedgames for fun, to
hone your skills, and to improve the different aspects
of your game. Take advantage of CHESSMASTER
9000’s new Blunder Alert feature, and set the analysis
features to the level of advice you want.

§ QuickStart!
If you want to jump right in and play
chess, simply click on the QuickStart!
button, and CHESSMASTER 9000
will set up a game for you, based on
your current chess rating. If you don’t
yet have a rating, CHESSMASTER
9000 will choose your opponent,
based on your rating choice when you
created your user.

13The Game Room

§ Setting Up Sounds, Voice, and Effects
CHESSMASTER 9000 provides a wide range of audio features that you can
control, such as the sound the chess pieces make when you move them on the
board or capture another piece, and whether or not certain features are narrated.
Sound changes are made by selecting Preferences from the menu bar of any
room, then choosing Sound and making any desired changes. OK saves the
changes and returns to play.

Selecting a Sound for Piece Movement

The sound your  pieces make when you move them on the board or capture
another piece depends on the option you select from the Piece Move m e n t
tab in CHESSMA STER Sounds. You can choose one of the fol lowing piece
m ovement sounds:

Spoken Move Announcements—The default option, which produces spoken
commentary for all moves made on the chessboard.

Thematic Sound Sets—Produces sounds related to the theme of the chess set
you’re using. Not all chess sets have a thematic sound associated with them.

Simple Sounds—A simple “clinking” sound.

No Sounds—Turns off sounds for piece movement altogether.

Note: For instruction on choosing your own piece sounds, see CHESSMASTER
9000 help.

§ Activating Narrated Features
CHESSMAST ER 9000 provides a var iety of narrated features. You can activa t e
or  deactivate these features using the V o i c etab from the CHESSMA STER
Sounds options:

Au t o - A n n o t a t i o n— Will autoplay  any Game Analysis or Advice audio to
accompany what’s currently being displayed in the Game Status and Annotation
w i n d ow s .

Natural Language Advice—Provides spoken
advice for your next move.

Illegal Move Commentary—Tells you when
you make an illegal move, and why.

B lunder Alert—This new feature in
CHESSMASTER 9000 does have spoken narration, but you must press the Play
button after you press the Why?button to find out why CHESSMASTER
thinks you are making a big mistake.

Defining Your Room Environment12
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personality, and then click OK.

4. In the Personality box, type a name for the new
personality.

5 .Cl ick the Se l e c tbutton next to Opening Book to
assign an opening book to the new personali ty .
(CH ESSMASTER stores its opening books as
.obk files in the Chessmaster 9000\Op e n i n g
Books folder. )

Note: An opening book is a series of opening moves and
counter moves that have been thoroughly analyzed. Each CHESSMASTER
personality has an opening book associated with it. For more on opening books, go to
the Library, and be sure to check out the Opening Book tutorials in the Classroom.
6. Edit the Style, Positional, and Material attributes you want.
7. Now click Save to finish the new personality.

8. At any time, you can remove a custom personality by selecting it and clicking
Delete. Keep in mind that you can’t delete the personalities that came with
CHESSMASTER 9000.

Setting Positional Options for the Personality
Use the Positional tab to determine the importance the personality places on the
position of the chess pieces on the board:
• Material/Positiondetermines how the personality values pieces on the board,

versus the overall positional attributes, such as pawn structure, attack potential,
piece mobility, forks, and so on. The range for this option is -100 to 100.
Negative values emphasize material, positive values emphasize positional, and
zero represents a balanced style.

• Control of Centersets how much the personality values controlling the center
of the board, especially the d4, d5, e4, and e5 squares, from both attack and
defense perspectives. The higher the setting, the more important center control
is to the personality. Opponent’s Control of Center determines how much the
personality is concerned with its opponent’s center control.

• Mobility sets how much the personality values placing its pieces to keep open
a maximum number of move opportunities. The higher the setting, the more
important mobility is to the personality. Opponent’s Mobility determines how
the personality will attempt to allow or inhibit the opponent’s mobility.

• King Safetysets how much the personality values keeping its king safe, or free
from attack, as opposed to being comfortable with a certain amount of
pressure if it frees other pieces from having to guard him. The higher the
setting, the more the personality tries to keep the king safe. It also values
Opponent’s King Safety in a similar manner.

• Passed Pawnssets how much the personality values developing passed pawns,
as opposed to other tactics. The higher the setting, the more the personality
wants to develop passed pawns. The personality also values the amount at
which it will allow Opponent’s Passed Pawns.

15The Game Room

§ Setting Up Game Details
If you want to modify other details of your game, you can also play an Unrated
game by selecting New Game from the pull-down menu or choose the New
Game shortcut button. 

To Play an Unrated Game in the Game Room:
1. Choose your opponent by selecting one of the

CHESSMASTER 9000 computer personalities,
creating a computer personality of your own, or
specifying a human player.

2. Select a time control, which determines how much
time is given for individual moves and/or the
entire game.

3. Specify your chess piece color and the side on
which you want to play.

4. Move a piece to start the game.

§ Choosing an Opponent
CHESSMASTER 9000 offers more than 150 unique opponents from beginner
to Grandmaster level, each with its own distinct playing style. You can also play
against a real player or a custom personality that you create yourself.

To choose an opponent in the Game Room:
1. From the Gamemenu, choose New Game.
2. Click the Computerbutton next to the Top

opponent box, and then click Personality.
3. Scroll through the list to view the available

personalities. Use the Filters tab to specify the
criteria for your opponent.

4. Use the Info tab to view the biography and
playing style of the current opponent.

5 . Select the opponent you want to play, then click O K. The name of the opponent
you selected appears in the Top opponent box of the Setup Game scre e n .

6. Click OK to close Setup Game Details.

To specify a human player as your opponent:
1. Click the Humanbutton next to the Top opponent box.
2. Type the name of your opponent in the opponent box and click OK.
3. To play a game online on Ubi.com, see the section on CMLive.

To create a custom personality:
1. From the Gamemenu, choose Set Up Personality.
2. Click the Selectbutton next to the Personality box.
3. Select the personality that you wish to use as a base for designing your custom
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• Po n d e r i n glets the personal ity think about its subsequent moves whi le yo u r
time is elapsing, which is much to its advantage. A check mark indicates
that this option is on (the default). To weaken the personali ty’s play, clear
this option.

§ Selecting a Time Control
One of the keys to enjoying chess is determining how much time to give yourself
and your opponent to complete a game. CHESSMASTER 9000 offers you
several time options, from rapid “blitz” to longer “classic” time controls. In
CHESSMASTER 9000, the chess clock is always running: When you make a
move, it stops your clock and starts your opponent’s clock running, and vice
versa. If you are playing a ratedor tournament game, and either player uses up
all of his or her time before completing the required number of moves, that
player loses the game. This does not apply in an Unratedgame.

To select a time control:
1. From the Gamemenu, choose Set Up Game.
2. Click the Time Controls tab.
3. From the drop-down list, select one of the following time controls:

Moves/Minutes—Specify the number of moves each player needs to make in a
certain number of minutes. Most chess tournaments are played at this rate. 

Seconds Per Move—Specify the number of seconds each player has to make a
move. In the Game Room, this is an unenforced Time Control, which means
that you can’t lose the game by running out of time (you can lose the game on
time in the Tournament Room). This Time Control is useful, however, for setting
the amount of time it takes for the computer to move. Keep in mind that this is
the average time it will take for the computer to move, and it may move more
slowly or quickly on an individual move.

Minutes Per Game—Specify the number of minutes each player has to complete
the entire game. If you select this time control, type the number of minutes in
the Minutes edit box. In CHESSMASTER 9000, any game where each play gets
15 minutes or more is considered “standard,” 3 to 15 minutes per player is
“blitz,” and less than 3 is “bullet” chess. (You receive ratings in Tournament and
Ratedgame play for each of these three categories, but not for Unratedgames
played in the Game Room.)

Fischer Style—Assign each player a specified number of minutes to complete the
game, with a certain number of bonus seconds added to the game each time a
player makes a move. If you select this time control option, set separate time
controls for each player.

Infinite Time—No time limitations for your game.

Hourglass—Each player gets a specified number of seconds per move at the start
of the game. As one player uses time, the other player gains the same amount of
time (like an hourglass). So, if you move rapidly, you can force your opponent to

17The Game Room

• Pawns Weakness sets how hard the personality avoids positions where a pawn
is unprotected, is rendered immobile, or otherwise weakens the overall pawn
structure. The higher the setting, the more the personality is concerned with
maintaining a solid pawn structure. The personality also values the amount at
which it will engender an Opponent’s Pawns Weakness.

Material Options
Use the Materialtab options to determine the importance the personality places
on its own chess pieces and those of its opponent.

The possible values for each piece are between 0.0 (no importance) to 15.0
(highest importance).

The default material points for chess pieces are:
Queen = 9
Rook = 5
Bishop = 3

Knight = 3
Pawn = 1

Style Options
Use the Style tab options to specify the playing style for the personality 
you’re creating:
• At t a c k e r / De f e n d e rsets the personali ty’s tendency to capture pieces, ranging

f r om -100 to +100. Ne g a t i ve values emphasize attack; posi tive va l u e s
e m p h a s i ze defense.

• St rength of Pl a y determines the quali ty of the personali ty’s play. A rank
n ov ice has strength of play at or near 0. A Grandmaster has strength of play
up to 100. Set the scroll  bar low for a weak opponent, or higher for a
g reater chal lenge.

• Randomnessadjusts the personality’s diversity of play, while maintaining its
strength of play.

• Max Search Depthsets the number of future moves towards which the
personality looks ahead.

• Selective Search determines how sensitive the personality is to non-useful
mov e searches, when analyzing the possible positions in a game. 

• Contempt for Draw determines how the personality reacts when you offer a
draw. If set at 0, the personality is more likely to accept a draw offer to draw if
the game is even. If set at 1, and it’s behind by less than a pawn (1 point), it
rejects the draw. If set at –2, and the personality is less than 2 points ahead, it
accepts the draw.

• Transposition Tablespeeds up the personality’s thinking and strengthens its
play by allowing it to skip a move it has already analyzed. The scroll bar allows
you to set aside a certain amount of memory for remembering prior analysis.
The more memory, the stronger and faster the play.

The Game Room16
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§ To force your computer opponent to move:
From the Actions menu, choose Force Move, which makes your computer
opponent move immediately, choosing the best move it has considered thus far.

§ To wake up your opponent:
From the Actions menu, choose Wake Up!

Note: Keep in mind that when you’re playing a computer personality, two actions can
interrupt the computer’s thinking — taking back a move and switching sides. In
either case, CHESSMASTER lets you wake up your opponent, so that it can start
thinking about its next move and resume the game.

§ To pause a game:
1. From the Actions menu, choose Pause.
2. Click OK to resume the game.

§ To take back your last move:
From the Actions menu, choose Takeback Move.

Note: If you take back a move, and you’re playing a computer personality, the
computer gets interrupted. In this case, choose Wake Up! from the Actions menu to
tell your opponent to make its next move.

§ To replay the move you just took back:
From the Actions menu, choose Replay Move.

Note:To return to the beginning of the game, open the Game Statuswindow from
the Windowsmenu, and click the right-most VCR button.

§ To offer a draw:
1. From the Actions menu choose Offer Draw. If CHESSMASTER accepts the

draw, a message appears indicating its acceptance. If CHESSMASTER declines
the draw, a message appears telling you to play on.

2. Click OK to end the game or continue the game respectively.
If CHESSMASTER declines the draw, and you still want to end the game, or if
you are simply frustrated and don’t think you can win, you can resign from the
game by choosing Resignfrom the Actionsmenu.

§ To change your side and piece color:
1. Just choose Switch Sidesfrom the Actions menu (or CTRL + I).
2. Switching sides interrupts the computer’s thinking. This means that if you’re

playing a computer personality, it won’t make its next move until you wake it
up. To resume the computer’s thinking so that it can make its next move,
choose Wake Up! from the Actions menu.

Note: If you’re playing Black, and you want to flip the board so that White is on top,
choose Flip Board from the Preferences menu.

19The Game Room

do the same. When you select this time control, you will need to type the
seconds allotted to each player in the Seconds Per Move edit box.

Note: The Se p a rate Time Controls option gives you two sets of time boxes, a di ffere n t
one for  each playe r. This is useful  i f you want more or less time than your opponent,
and is a good way of balancing the game between players of different skill levels. To use
this option, simpl y type the number of moves and minutes in the re s p e c t i ve edi t boxe s .

§ How to Move Pieces and Start a Game
A game begins as soon as you or your opponent makes the first move. If you are
White, you need to make the first move. If your opponent is White, you must
wait until your opponent moves. Using the mouse is the easiest and most
common way to move your pieces.

§ To move a piece with your mouse:
1. Place the pointer over the chessboard. The pointer changes to a hand.

2. Click the chess piece you want to move and hold down the left mouse button
to drag the piece to its destination square. The hand grabs the piece as you
drag it. Release the mouse button to place the piece on that square. This is the
default way to move pieces.

3. You can also choose the Two-Click Movesoption, which lets you move pieces
by clicking once to pick up the piece, and clicking again to drop the piece on
its destination square. To select this option, go to Board Settings. (See
Configuring your Chessboard in Defining Your Room Environment.)

4. If you make an illegal move, CHESSMASTER returns the piece to its original
square, and if Illegal Move Commentary is on, CHESSMASTER tells you why
the move is illegal.

5. If you make a mistake, in the Game Room, you can choose Takeback Move
from the Actions menu.

6. If you’re having difficulty grabbing a chess piece, make sure the index finger of
the hand is inside the square of the piece you want to move.

Note: Remember that Quick Entry and Sliding Pieces options let you determine how
you and your opponent move pieces on the board. For more information, refer to
“Configuring Your Chessboard.”

To move a piece with the keyboard:
1. Type the destination square for your piece using the current notation.

2. For example, if you were using Algebraic notation, and wanted to move your
King pawn two squares, you would type e4.

3. In general, we recommend that you move your pieces with the mouse.
However, the only way to play Blindfold games is via the keyboard.

In-Game Options
In the Game Room, CHESSMASTER gives you a number of options to speed up or
pause play, force moves, ask for a draw, save your game, and even to take back move s .

The Game Room18
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To copy the Game Status window to the Windows clipboard:
1. From the Edit menu, choose Copy, then choose Move List or Move List

(w/Tabs). The Annotation Type appears.
2. Specify the annotation you want to include:

• No n e—Copies the moves from the Game St a t u sw i n d ow without annotations.
• Player—Copies the moves with any annotations you entered in the Player

tab in the Annotationwindow.
• Analysis— Copies the moves with CHESSMASTER’s analysis of the

position, which includes the evaluation and theoretical-best lines of moves.
• Au t o - A n n o t a t i o n—Copies the moves with CHESSMASTER’s annotations.

3. CHESSMASTER copies the Game Status window’s move list to the
Windows clipboard as ASCII text.

To copy the Board Position to the Windows clipboard:
1 .From the Ed i t menu, choose C o p y, then choose one of the Board

Position options:

• ASCII Board Position copies the current board position in ASCII text
format to the Windows clipboard. An ASCII board consists of characters
and dashes. The dashes represent empty squares, and the characters
represent the chess pieces. For example, BR represents the Black Rook, WR
represents the White Rook, BN represents the Black Knight, WN represents
the White Knight, and so on. The following illustrates an example of an
ASCII chessboard:
Note: Before you paste an ASCII chessboard into a word-processing application,
use the application’s Font command to select a non-proportional font, such as
Courier, to align the ASCII text correctly.

• Board Position w/ Chess Font copies the current board position to the
Windows clipboard using the chess font.
Note: Before you paste a copied chess font board diagram into a word processing
application, use the application’s Font command to select the CHESSMASTER
TrueType font.

• Graphical Board copies the current board position (complete with graphics)
to the Windows clipboard.

2. The text or image is copied to the Windows clipboard.

21The Game Room

BR BN BB BQ BK BB — BR
BP BP BP BP BP BP BP BP
— — — — BN — — —
— — — — — — — —
— — WP — — — — —
— — — — — — — —

WP WP WP — WP WP WP WP
WR WN WB WQ WK WB WN WR

To adjourn a game:
1. From the File menu, choose Save. (If you are playing in the Tournament Hall,

you can choose Adjourn from the Actions menu.)

2 .Speci fy the folder, file type, and fi le name to which you want to save the
game. You should always save adjourned games as CHESSM ASTER Ga m e
(CM G) files.

3. Click Save. CHESSMASTER saves the adjourned game to the specified
location and file name.

To resume an adjourned game:
1. From the File menu, click Load. The File Open dialog appears.
2 . From the Look In dro p - d own l ist, select the folder that contains the

adjourned game.
3. From the File of Type drop-down list, select CHESSMASTER Games (CMG).
4. Select the game, and then click Load. CHESSMASTER opens the game.

To print the current board position:
From the File menu, choose Print > Board Position. CHESSMASTER prints
the image of the current chessboard. 

Note: To perform standard Windows print operations, such as selecting a printer,
specifying a page range, and specifying the number of copies, choose Print > Setup
Printer from the File menu.

Using the Game Status Window
CHESSM ASTER re c o rds each move you and
your opponent make during a game. It re c o rd s
the moves in the Game St a t u sw i n d ow, using
the current chess notation. The Game St a t u s
w i n d ow (which is stored with its corre s p o n d i n g
game) can be accessed from the Wi n d ow sm e n u .

To open and close the Game St a t u s
w i n d ow :
From the Windowsmenu, choose Game
Status. The Game Status window appears. The
chess piece symbol next to the menu option
indicates that it is open.
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4. Click Play to hear CHESSMASTER’s Illustrated Voice Analysis (IVA) 
explain the suggested move. To stop the IVA, click Stop, which will rewind it
to the beginning.

5. Click the Closeicon (X) at the upper-right corner of Move Advice to close it.

To use the Chess Coach:
1. From the Mentormenu, choose Chess Coach. 
2. The Chess Coachwindow appears. 
3 . Click the tab you want to use—Advice, Database Findings, or Teaching Mo d e s .
4. To close the Chess Coachwindow, select it again from the Mentormenu or

click the Closeicon (X) on the upper-right corner of the window.
5. If you open the Chess Coachwindow during a game, CHESSMASTER

provides a running commentary on the tactical features of a position. If you’re
not sure why a move does what the Chess Coach says, make the move on the
board, examine the position carefully, and then try to determine what the
Chess Coach means.

A dvice Ta b— Provides a summary of all possible moves and their significance.
This gives you a great way to learn how the opening variations are related to
each other. When the game is out of the opening book, a short description of
each move’s impact on the game appears. This might be “Pins knight,”
“T h reatens mate,”  or “Hangs queen.”  The A d v i c etab also explains the tactical
m o t i ves the moves invo l ve. When this tab is displayed, you can double-click any
m ove to make the suggested move .

Database Findings—Lists all the games in the CHESSMASTER 9000 database
that have the current position. It shows the number of wins, draws, losses, and
winning percentage of those games.

Teaching Modes—See the next section.

Using the Teaching Modes
The Teaching Modestab in the Chess Coachwindow (described above) lets you
take advantage of the audio and visual tips that CHESSMASTER provides.
These teaching modes can help develop and improve your strategic and tactical
playing skills and enhance your awareness of the different positions during play.
If you’re new to chess or just want to improve your skills, you can use the
teaching modes to inform you of minor tactics, threatened pieces, and board
coverage by highlighting and ghosting the appropriate pieces on the chessboard.

The CHESSMASTER teaching modes are described below:

§ Legal Moves—Shows you the possible moves a selected piece can make. You
simply click the piece you want to move, and ghost pieces immediately appear in
all the squares to which the piece can move. You can then drag your piece to
make the move. If a destination square is occupied by an opponent’s piece, that
piece is “ghosted” or opaque, indicating you can capture it. 
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To print the Game Status window:
1. From the File menu, choose Print > Move List.

2. Specify which annotation you want to include.
3. Click OK. CHESSMASTER prints the moves from the Game Status window

with the annotations you selected. The name of each player appears at the top
of the list, followed by all moves in the current notation.

Getting Advice
When playing in the Game Room, you can ask CHESSMASTER for help in a
number of ways: Quick Hint, Blunder Alert, Chess Coach, or Move Advice.

§ To use Quick Hints:
1. From the Mentor menu, choose Quick Hint , which offers a suggestion for

your next move.
2 .Cl ick Ye sto make the suggested move, or  No i f you don’t want to make

the move .

3. Keep in mind that CHESSMASTER uses the current notation to suggest the
move. So, it is a good idea for you to accept CHESSMASTER’s suggestion, at
least until you learn about chess notation.

§ To use Blunder Alert:
1 . From the Me n t o rmenu, choose Blunder Alert .
2. When you make a move that could result in

checkmate, or the loss of significant material,
the Blunder Alert will pop up on screen.

3 .Click on the W h y ?button to find out why
CHESSMA STER t hinks you are making a
big mist ake. 

4. You can either Take Backthe move, or
Disagreewith CHESSMASTER and make
the move anyway.

5. Unless you are an advanced player, we
strongly recommend that you accept
CHESSMASTER’s suggestion and try a
different move.

To use Move Advice:
1. From the Mentor menu, click Move Advice.
2. Type the number of seconds you want

CHESSMASTER to use to analyze your
position and determine the best move, and then click OK. CHESSMASTER
uses the specified amount of time to think, and then suggests a move.

3. Scroll through the text to read about the suggested move, and then make the
move, or
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§ Pieces That Can Be Captured—Shows all pieces that can be captured based
on the current board position. Use this mode when you are confident that you
understand the basic moves of each piece. 

§ Threatened Pieces—Shows all the pieces that can be captured by your
opponent in the next move. In other words, it ghosts all the pieces that are under
attack for the player who is about to move. Use this mode to help you recognize
your opponent’s threats.

Pinned Pieces—Shows pieces that cannot or should not move because they’re
protecting a more valuable piece. The ability to identify pinned pieces is a
middlegame tactic essential to the repertoire of any good chess player.

Skewered Pieces—Highlights those pieces that are protecting pieces of lesser
attack value on the same rank, file, or diagonal. The ability to identify skewered
pieces is another essential middlegame skill.

Isolated Pawns—Exposes pawns that are not directly supported by another pawn
of the same color and are potentially weak. 

Passed Pawns—Highlights pawns with no enemy pawns in front or adjacent to
the same file. Passed pawns are considered strong because their path to
promotion is clear. The ability to identify passed pawns is an essential part of
endgame tactics.

Teaching Off turns off the currently selected teaching mode.

Note: You can only turn on one teaching mode at a time. Also, some chess sets and
board colors may display Teaching Mode better for your needs. So, feel free to
experiment with different chess sets.
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ANALYZING GAMES IN THE GAME ROOM
With CHESSMASTER 9000’s advanced analysis features, you can:
• Save and load a game
• Set up a specific position on the chessboard
• Annotate a game
• Study a game with CHESSMASTER’sVisual Thinking and Mentor Lines
• Copy a game from another room to the Game Room

• Enter information on a current game
• Solve a position for checkmate

Saving and Opening Games
The first step to effective game study is saving as many of your games against as
many different opponents as possible. After you save a game, you can open it at
any time and examine it move by move. This is essential in gaining an
understanding of your personal strengths and weaknesses as a chess player.

CHESSMASTER 9000 lets you save the current game (completed or not) to a
CHESSMASTER Game (CMG) file or to a Portable Game Notation (PGN)
file. Use CMG if you want to save all annotations, including the opponents,
analysis, auto-annotation, and Illustrated Voice Analysis (IVA) information. Use
PGN if you want to open the game in a text application, or another chess
program, as the PGN format is the recognized standard for saving a chess game.

Note: To turn sound on and off for Game Analysis, choose Soundfrom the
Preferencesmenu, click the Voicetab, and then check or clear Auto-Annotation.
For more information, see “Setting Up Sounds, Voice, and Effects” in “Defining Your
Room Environment."
To save a game:

1. From the File menu, choose Save.
2. From the Save In drop-down list, specify the

folder where you want to save your game.
3. From the Save As Type list, choose a file type

for your game. Select CMG if you want to open
the game later in CHESSMASTER 9000. Select
PGN if you want to export the game to another
chess application.

4. In the File Name box, type a name for the game you’re saving. You can use the
default (based on the players and the date) or type your own.

5. Click Save. CHESSMASTER saves the game to the specified folder, file type
and name.

Note: CHESSMASTER9000 automatically saves all of your Rated Games in PGN
format, in your Users directory, but doesn’t save your Unrated games.
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Game Analysis and Annotation
Game Analysis also lets you play through the commentary, using the VCR
buttons and the Move Listwindow in the Game Statuswindow. It focuses on
possible variations and evaluates positions using CHESSMASTER 9000’s
decimal-point system. In that system, a one-point (1.0) advantage is equivalent
to possessing an extra pawn; a three-point (3.0) advantage to possessing an extra
minor piece; a five-point advantage (5.0) to possessing an extra rook; and a nine-
point advantage (9.0) to having an extra queen. CHESSMASTER expresses
advantages less than a pawn in fractions of a point. For example, a .50-point
advantage is equivalent to half a pawn advantage. In the Game Room, you can
annotate and analyze the moves for any game (whether completed or not,
including games loaded from a file or games you are currently playing.)

To have CHESSMASTER annotate a game:
1 .From the Wi n d ow smenu, choose 

Game St a t u s.
2. “Rewind” the game to the beginning, using

the VCR buttons at the top of the Game
Statuswindow.

3. From the Mentormenu, choose 
Game Analysis.

4. Specify the number of seconds you want
CHESSMASTER to spend analyzing each
move, and then click OK. CHESSMASTER
displays a message indicating when it is finished.

5. Click OK, then choose Annotationfrom the menu.
6 .Click the A u t o - A n n o t a t i o nt a b, then cl ick Pl a y, or use the Play VC R b u t t o n

in the Game St a t u sw i n d ow, to see and hear CHESSM ASTER’s eva l u a t i o n
of the game.

7. Click Pauseto stop the Auto-Annotation, or use the VCR buttons in the
Game Statuswindow to scroll through the moves one at a time.

Then, to check out CHESSMASTER’s analysis:
Do steps 1-5 above, then
6. Click Analysis Taband then click Play to see CHESSMASTER’s decimal

point score for the position.

To annotate a game yourself:
1. Click Player in the Annotationwindow.
2. Select the move you want to annotate in the Game Statuswindow.
3. Click Edit, and then type your comments.

4 . Click O K to end your annotation or use the VC Rbuttons in the Game St a t u s
w i n d ow to scroll through the moves. (IVA  is not available for player annotations.)

To open an existing game:
1. From the File menu, choose Load.

2 . From the Look In list, specify the folder that contains the game you want to open.
3. From the File of Typelist, specify the type of game you want to open. Select

CMG format to open a game from an earlier version of CHESSMASTER, or
PGN to open a game from another chess program.

4. In the Open As edit box, make sureAuto is selected, and then click Load.
CHESSMASTER 9000 then opens the selected game on the chessboard.

5 . If the Game St a t u sw i n d ow isn’t open, choose Game Status from the Wi n d ow s
menu, and then use the VC Rbuttons to scroll through each move of the game.

Note: CHESSMA STER 9000 also provides a libra ry of over  800 classic games.
For  more information on studying and analyzing these classic games, see “T h e
Li b ra ry”  section.

Setting Up a Position
CHESSMASTER provides a Board Position feature that lets you set up a specific
position on the chessboard, and then either have CHESSMASTER analyze it for
you, or you can play it out yourself.

Note: You cannot use this feature to set up an
illegal position.

To set up a position:
1 . From the Ga m emenu, choose Set Up Po s i t i o n .
2. Click either

a . Clear Bo a rd to leave only the two Kings, or 
b. Starting Positionto set the board to its

starting position.
3. Click any Piecebutton.
4. Then click the location on the chessboard where you want that piece to

appear. If a piece of that type is already in that square, then it is removed.
5. Click the Handbutton to move an existing piece to a new location.
6. Click the X button to remove a piece from the chessboard.

7. Click Apply.
8. Use the Side to Move options to specify whose turn it is. Click White if you

want the white pieces to move first; click B lack if you want the black pieces to
move first. 

9. Choose OK. CHESSMASTER displays the board position you set up.

Note:You can cancel the Setup Board Position operation at any time and return to
the game in progress. Simply click the Cancelbutton.
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To copy a game from another room:
1. From the Edit menu, choose Copy Game From, and then from the cascading

menu, choose the room from which you want to copy a game.
2 .CH ESSMASTER copies the game from the speci fied room onto the

c u r rent chessboard .
3 . You can then use any analysis functions, and save the game as a PGN or

CM G file.

Entering Game Information

To enter Game Information on a current game:
1. From the Gamemenu, choose Game Information.

2. In the Title box, either keep the default title, or type a new title of your choice,
such as “TC vs Morphy 1868”

3. Enter any player names, titles, and country of origin for White and Black.
4. In the Site box, type where the game was played.
5. Enter the name of the annotator.
6. The ECO box displays the opening code in the current chess notation.
7. In the Remarks box, enter any comments you have regarding the game.
8. Specify the result of the game:

a. Game Not Over
b. White Won
c. Black Won
d. Draw

9. Click OK. CHESSMASTER stores the information you entered with the
corresponding game.

Solving for Mate

To find a checkmate:
1. From the Mentor menu, choose Solve for Mate.
2 .Type the number of moves (from 1 to 30) you want CHESSM A STER to

look ahead to solve for checkmate. If you enter  more than 5, the search can
take a while.

3. Click OK. CHESSMASTER searches all possible positions looking for
checkmate and displays the number of the positions as it analyzes the game.

4. When CHESSMASTER finishes its search, and it finds the checkmate in the
number of specified moves, it asks if you want to see the moves.

5. Click Moveto see the moves, and then click OK to reset the board to its
original position.

To save any game with annotations and analysis:
1. Choose Savefrom the File menu. 
2. Select CMG as the file type.
3. Specify a name and location for the game, and click Save.

Studying games with Visual Thinking and Mentor Lines

To use Visual Thinking:
1. From the Windowsmenu, choose Visual Thinking.
2. Watch the chessboard dynamically update as

CHESSMASTER considers its best line.
3. Use the VCR controls to move back and

forth in the display.
4. Use the Hold and Resumebuttons to pause

and resume Visual Thinking.
5. To close the Visual Thinking window, select

it again from the Windowsmenu or click the
Closeicon (X) on the upper-right corner of
the window.

6. Visual Thinking is only available in the Game Room.

To use Mentor Lines:
1. From the Mentor menu, choose Mentor Lines.

2 .Watch the window dynamical ly update as
CHESSMA ST ER considers its best line.

3. The display will show
a. The time CHESSMASTER takes to

predict the moves
b. The number of moves (depth) that

CHESSMASTER is thinking about
c. The material and positional advantage (score) that would result if all the

moves are played out as predicted by CHESSMASTER

Note: A positive score means that White is winning, and a negative number means
Black is winning.
4. Thinking Lines are only available in the Game Room and Library.

Copying Games from Other Rooms
CHESSMASTER 9000 allows you to copy a game from any other room into the
Game Room, to take advantage of some of the unique analyzing tools only
found in this room.
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2. Otherwise, choose either Beginning or Intermediate.

3. Click the Tutorials button.
4. Click + or- to expand and collapse the topics.
5. Select the tutorial you want, and then click OK.
6. Read, listen, and watch the first page of the tutorial.
7. Click Next to continue.
8. If the tutorial asks you a question, click the appropriate answer, or if

instructed, make your move on the board.

9. Click Cancelat any time to end the Tutorial.
1 0 .When you complete a tutorial , a red checkmark appears next to it in the

tutorial list.

§ To Select and Run a Drill:
1. Choose either Beginning, Intermediate, or A dvanced.

2. Click the Drills button.
3. Follow the instructions in Drills, as you did in the Tutorials.

To Take a Rating Exam:
1. Select the Intermediatetab.
2. Click the Rating Exambutton, then click +

to see the available exams.
3. Select the rating exam you want, and then

click OK.
4. You then see a series of questions. 
5. If the tutorial asks you a question, click the

appropriate answer, or if instructed, make
your move on the board.

6. Click Next to continue. 
7. After you finish, CHESSMASTER rates your performance.

8. This rating does not affect your playing strength rating in CHESSMASTER
9000—it is simply to let you know how well you did on the exam.

Practicing Your Openings
Opening moves in chess have been studied and
improved upon for hundreds of years.
CHESSMASTER 9000 recognizes over 2,200
opening book lines, and you can practice any of
these openings in the Classroom. 

To practice an opening book sequence:
1. Click the Intermediatetab.
2. Click Practice Openings, and then click OK.

THE CLASSROOM
Whether you’re a beginner, intermediate, or
advanced player, you’ll find the tools you need
to improve your chess game in the
CHESSMASTER 9000 Classroom. There are
tutorials on everything from the basics of
moving the pieces, to the intricacies of pawn
structure and how to set up a Kingside attack. 

The Classroom allows you to:
• Specify Your Level of Instruction 
• Select and Run a Tutorial
• Select and Run a Drill
• Take Diagnostic Rating Exams
• Practice Your Openings

• Learn From IM Josh Waitzkin
• Match the Masters
• Take the Larry Evans Endgame Quiz
• Try John Nunn’s Chess Puzzles

Note: If this is your first time using the Classroom, you should consider reviewing
“Defining Your Room Environment," so that you can set up the Classroom chess sets,
sounds, and windows as you like.

§ Specify Your Level of Instruction:
1. Select the Beginning, Intermediateor

Advancedtab
2. Or select the Josh tab to access special

features from CHESSMASTER consultant,
International Master, Josh Waitzkin.

3. Now choose a specific area of instruction.

If you’re a beginner, you can choose from a
number of tutorials or drills. As an intermediate
player, you can choose from more complex
tutorials and drills, take the Larry Evans
Endgame Quiz, challenge yourself with a rating
exam, or practice your openings. If you’re an advanced player, you can try more
advanced drills, and check out special features such as Bruce Pandolfini’s Match
the Masters, or John Nunn’s Chess Puzzles.

§ To Select and Run a Tutorial:
1 . If yo u’re new to chess, you should start with the “Your First Chess Lesson” tutorial.
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To select a game to match:
1. Click the Advancedtab
2. Click the Match the Mastersbutton.
3. Choose the game you want and click OK. In

general, we recommend that you begin with
the first game, and move down the list.

4. Read the text setting the stage for the game.
5. Then click Next to begin the game.
6. The beginning moves will quickly be played

out, and then you will see several move
options written in the currently selected chess notation.

7. Select an answer and click on OK to see how close you match the Master’s
decision. If you want to skip that move, click Next.

8. You are told if your choice was correct. Even if you did not choose the same
move that the Master made in the game, you might still get partial or even full
credit for the move that you chose.

9. Click Next to go on to the next move.
10. Click Cancelat any time to leave Match the Masters.
11 .A t the end of the game, Pandolfini rates your play.
12.This rating does not affect your playing strength rating in CHESSMASTER

9000—it simply lets you know how well you did in Match the Masters.

Take the Larry Evans Endgame Quiz
1. Click the Intermediatetab.
2. Click the Endgame Quiz button.
3. Read the text setting the stage for the quiz.

4 . Each question will give you an endgame posi tion
on the Classroom chessboard, taken fro m
famous games or composed endgame studies.

5. Select an answer from the three provided.
6. Unlike Match the Masters, there is only one

correct answer for each question in the Larry
Evans Endgame Quiz.

7. You are told if your choice was correct; click Next to go on to the next 
quiz question.

8. There are 50 questions in all.
9. Click Cancelat any time to leave the Endgame Quiz.
10 .At the end of the game, Larry Evans rates your play.

11 .This rating does not affect your playing strength rating in CHESSMASTER
9000—it simply lets you know how well you did in the Endgame Quiz.

3. Click + and - to expand and collapse openings and variations. 

4. You can search for a specific opening by entering a word such as “Indian” or
“Gambit” into the Search box and clicking the Search button. This brings up
a list of opening books that have that word in their name.

5. Select the practice opening you want, and then click OK.
6. You are then instructed in the selected opening. 
7. A t any time, click on Hint, and CHESSMASTER will prompt you on the

next move in the sequence.
8. CHESSMASTER lets you know when the practice is complete. 
9. Click on New to select a new opening book to practice.

10. Click Cancelto return to the Classroom.

§ Learn from IM Josh Waitzkin
One of the best ways to learn and improve your play is to study with a master-
level player. CHESSMASTER 9000 offers you the next-best thing, by including
a number of features from International Master Josh Waitzkin. Whatever your
skill level, these features—including situations taken from Josh’s own games—
provide a number of ways to study chess:
• Study Josh Waitzkin Games

• Study the Endgame Course
• Study the Psychology of Competition Course

To study a Josh Waitzkin game or course:
1. Click on the Josh tab.
2 .Then select the A nnotated Ga m e s ,

Endgame Course, or Ps ychology of
C o m p e t i t i o nb u t t o n .

3. Select the game you want, and then click OK.
4. Josh talks about and illustrates each move in

the list.
5 . Pa u s estops the IVA in its current state so that

when you play it again, it starts where it left off.

6. Stop rewinds the game to the beginning of
the current annotation.

7. Use the VCR buttons to step through the moves one-by-one.
8. Click the Close(X) icon in the upper-right corner to leave the game.

Match the Masters
In this Advanced exercise, renowned chess teacher Bruce Pandolfini lets you play
through games of famous chess masters, where you try to make their moves (or
even better ones). Match the Masters is in a multiple-choice format, and you
score variable points for each answer, depending on how right or wrong you are.
At the end of each game, Pandolfini rates your play.

The Classroom The Classroom 3332

Chess_PC_Manual.qxd  7/22/02  1:16 PM  Page 32



4 .Click Pe r s o n a l i t yto view the detail s for
each opponent.

Note: Until y ou have played 20 Ratedgames,
your chess rating is “provisional” and you can only
challenge opponents within 400 points of your
score in an upward direction. You can challenge
any lower-rated opponents you like.
5. Select a time control (Minutes per Game,

Moves per Minutes, Fischer Style)
6. When you play a Ratedgame, CHESSMASTER doesn’t assign you a default

color. You can either specify a color, or ask CHESSMASTER to randomly
assign you a color.

7. Move a piece to start the game.

8. Using the Game Status window is the same as in the Game Room.
9. Keep in mind that you have no Hints, Blunder Alert, or Coaching windows

available to you in the Tournament Room.

Pausing or Ending a Game

To Pause a game
1. From the Actionsmenu, choose Pause.
2. Click OK to resume the game.

To Adjourn a Game
1. Select Adjourn from the Preferencesmenu.

2. If it is your turn to move, CHESSMASTER 9000 requires you to make a
sealed move before you adjourn the game.

3. Make the next move in your game, and the game will be saved automatically.
4. When you resume your adjourned game, your sealed move will automatically

be made, and it will be your opponent’s turn to move.

To Resume an adjourned game:
1. Select Load ->Load Adjourned Rated Game.
2. The list of your saved games will appear.
3. Select the game you wish to play.
4. When you resume your adjourned game, your sealed move will automatically

be made, and it will be your opponent’s turn to move.

To offer a draw:
1. You can offer a draw in the Tournament Room, just as you would in an

Unratedgame.
2. From the A ctionsmenu choose Offer Draw.
3. CHESSMASTER will either accept or reject the draw.

Try John Nunn’s Chess Puzzles
CHESSMASTER 9000 provides a series of “Brain Te a s e r” puzzles from Br i t i s h
Grandmaster John Nunn, which are a nice change of pace from playing chess games. 

To select a puzzle to solve:
1. Click the Advancedtab.
2. Click the Nunn’s Puzzlesbutton
3. Then click + to see the available puzzles.
4. Choose the puzzle you want, and then click OK.

5. Read the intro to the puzzle.
6. Attempt to solve the puzzle.
7. CHESSMASTER lets you know if your answer was correct.
8. If the move is correct, click O K, and then click Ne x t to move to the next puzzle.
9. If the move is incorrect, click OK to try again.
10 .Click Hint if you need help from CHESSMASTER.

1 1 .Click Cancelat any time to cancel the puzzle.

THE TOURNAMENT ROOM
Welcome to the Tournament Room, where you set up tournaments and play
Ratedgames. Unlike Unratedgames in the Game Room, Ratedgames affect
your overall chess rating. So, everything counts— there’s no taking back moves,
no advice, no coaching, and no hints. It’s between you and your opponent. 
In the Tournament Room, you can learn how to:

• Play a RatedGame
• Pause or End a RatedGame
• Create and Run a Tournament
• View and Print Tournament Results
• Suspend, Adjourn, and Open Tournaments

Note: If this is your first time using the Tournament Room, you should consider
reviewing “Defining Your Room Environment," so that you can set up the
Tournament Room chess sets, sounds, and windows as you like.

Playing a Rated Game
1. Click on the Rated Gamebutton in the

Shortcutwindow, or select Rated Game
from the pull-down menu.

2. Choose your opponent from the list.

3. On the upper right are three numbers,
showing the affect on your rating should you win, lose, or draw against the
selected opponent.
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12.Click Next.
13.Now add any human players (such as yourself) to the tournament list of

participants, using the same procedure outlined in step 8.
14.Click Nextagain.
15. In the# of Roundsbox, type a number. CHESSMASTER displays the

number of games in the tournament, depending on the tournament type and
number of rounds you specify.

16.Click Finish.
17. In the Sa ve In b ox , specify a location and name for the saved tournament.

CH ESSMASTER saves the tournament as a CMT file with your specifications.

To schedule a tournament:
1. Normally, you will see the Tournament Schedule immediately after you create

a tournament and save it.
2. If the Tournament Schedule isn’t open, choose Tournament > Schedulefrom

the Gamemenu.
3. If the tournament includes human players, click Select, which requires that

you manually start all the rounds in the tournament. When a round ends, the
Tournament Schedule reappears, prompting you to select the next round.

4. If the tournament includes only computer players, click Auto, and
CHESSMASTER will schedule and play the tournament rounds for you.

5 .Once you click either Se l e c tor Au t o, the selected round begins. W h i t e
m oves first.

6. Once all rounds of the tournament are complete, the Tournament Results
will appear, displaying wins, losses, draws, total game points for each round,
and the overall score of each participant.

To View and Print the Tournament Results
1 . No r m a l l y, once all rounds of the tournament are complete, the To u rn a m e n t

Re s u l t swill appear.

2 . If the Tournament Results are n’t open,
choose To u rnament > View Re s u l t sf ro m
the Ga m em e n u .

3. Click Games.
4. The Games Playedappear with a summary

of each completed round.
5. Click OK to return to Tournament Results.
6. Then click OK again when you’re finished reviewing the results.
7. From the File menu, choose Print TournamentResults.

8. Click OK. CHESSMASTER prints the tournament results using the settings
you specified.

4. Click OK to end the game or continue.
5. You can also resign from the game at any time by choosing Resignfrom the

Actionsmenu.

How to Create and Run a Tournament
Have you ever wondered how the first generally acknowledged world
champion—the great 19th-century American Paul Morphy—would fare against
today’s competition? You can use the GM-Style opponents included in
CHESSMASTER 9000 to set up such dream matchups. You can even include
yourself as a contender, and see how you do against any of the 150+
CHESSMASTER opponents.
The CHESSMASTER 9000 Tournament Room lets you:
• Create and save a tournament
• Schedule a tournament

• Suspend a tournament in progress
• Open an existing tournament you saved
• View and print the tournament results.

To create a tournament and save it:
1. From the Gamemenu, choose 

Tournament > Create.
2. Set the Tournament Type

a. In a Round Robin tournament, each
player plays all the others.

b. In a Swissevent, the players are matched
according to their progressive scores after
each round.

3 . Select the number of players in the tournament. CHESSMASTER 9000 displays
the maximum number of participants allowed in each type of tournament.

4. Specify a time control. This will be followed for every game in the
Tournament.

5. Check the Rated Tournamentcheck box, if you want the tournament results
to affect the human participants’ overall rating.

6. Click Next.
7. Then choose the tournament participants.
8. From the right column, select the opponent you want to add as a participant,

and click <<. The selected opponent appears in the left list of tournament
participants.

9. Repeat this step for every opponent you want to add.

10. If you want to remove a participant, click >>.
11. If you want to check out the playing style, or biography on each available

opponent, click the Personalitybutton.
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THE LIBRARY
Welcome to the CHESSMASTER 9000 Library. Here, you can:

• Study more than 800 Classic Chess Games
• Study Chess Openings

• Create your own Opening Book

Note: If this is your first time using the Library,
you should consider reviewing “Defining Your
Room Environment," so that you can set up the
Library chess sets and windows as you like.

Studying a Classic Game
CHESSMASTER 9000 provides a library of more than 800 classic games, which
span some four centuries of master-level chess. These games are annotated by
five-time US Champion GM Larry Evans, among others, so that you can learn
from and enjoy games played by the best players in chess history .

§ To view a Classic Game:
1. From the Gamemenu, choose Load Classic

Game, or click on the Classic Gamebutton in
the Shortcut window.

2. If you wish to scroll through the games in
order, they are listed chronologically, beginning
in 1619.

3. Use the Search function to sort for games
involving a particular player, year, or location.
Type the word you wish to search for in the box, and click Search to bring up
a list of games with that keyword in them.

4. Select the classic game you want to open, and then click OK.
5. CHESSMASTER opens the selected game on the chessboard.
6.. Use the VCR buttons to scroll through each move of the game in the Game

Statuswindow.

7. You can then read the comments on each game in the Annotationwindow.
8. The Mentor Lines and Coach windows are available in this room to assist you

in your Classic Game study.
9. Don’t forget that you may also copy the classic game to the Game Room with

the Copy Game From drop-down menu command. You can then add your
own comments, or have CHESSMASTER analyze the game.

Suspending Tournaments
To be fair to all players, CHESSMASTER asks the human player to make a
sealed move before adjourning the tournament. CHESSMASTER resumes an
adjourned tournament by starting with the sealed move of the human player, so
the sealed move isn’t revealed until the tournament resumes.

To adjourn the current tournament in progress:
1. From the Actions menu, choose Adjourn.
2. If it is a human player’s turn to move, that player must make a sealed move,

just as in a RatedGame. 

To open an existing tournament:
1. Click on Load > Load Tournament
2. Use the L o o k - In menu to find the folder that contains the CMT file you save d .
3. Open the CMT file you saved.

4. CHESSMASTER plays the sealed move, and the tournament begins from
where it left off.
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tree, and you can use - to collapse the tree.
10. The boxes above the Opening Moveswindow update dynamically as you

select different moves in the Opening Moves tree:
a. Openinggives the general name for that line of opening moves.
b. Movesdisplays the opening move and countermoves, up to and including

the selected move.
c. Variationdisplays the variation name of the selected opening move or

countermove.
d. ECO displays the opening code of the selected move. The ECO code is a

chess convention that CHESSMASTER 9000 supports. It appears for
informational purposes only.

e . We i g h tdisplays one of four values (0, 25, 50, or 100) which indicate how
often the selected move is used. For example, suppose the current opening
book contains three opening moves —e2-e4, b2-b4, and d2-d3—and they
each have corresponding Weight values of 25, 50, and 100, re s p e c t i ve l y. In
other words, the weight of e2-e4 is 25, b2-b4 is 50, and d2-d3 is 100. If a
g i ven move has a Weight of 0, then the probabil ity of that move being used
is ze ro.

1 1 .The Mentor Linesand Coachwindows are available in this room to assist you
in your study of Chess Openings.

Create Your Own Opening Book

To create a new Opening Book from scratch:
1. From the Opening Book menu, choose

either New Opening Book to start from
scratch, or Edit CHESSMASTER Book to
edit one of the opening books that came with
CHESSMASTER 9000.

2. Using the chessboard, make the first opening
move. The opening move appears in the
Opening Moveswindow, and also in the
Moves box.

3. If you want, type a name in the Variation box
for the opening move.

4. From the Weight drop-down list, choose a
weight value for the opening move. (For
detailed information on weight values, see the previous section.)

5. Make the first countermove.
6 .CHESSM A ST ER updates the Opening Move sw i n d ow and the Move s

b ox accord i n g l y.
7. Repeat steps 3 and 4 for the first countermove, which will appear in the

second column (1. …) of the Opening Moveswindow.

Studying Chess Openings
An Opening Book is a repertoire of opening moves and countermoves. Opening
Book theory has been improved upon by great chess masters for hundreds of
years, and these files are available for you to study in CHESSMASTER 9000 for
your own chess development. 
CHESSMA STER has compi led a single-master Opening Book Re f e rence, which
you can think of as an encyclopedia of known opening moves. To get the most
out of the Opening Book Re f e rence, you should use it in conjunction wi th the
Game St a t u sw i n d ow and A n n o t a t i o nw i n d ow. The Game St a t u sw i n d ow lets
you scroll through the moves in the Master Opening Re f e rence using the VC R
buttons. The A n n o t a t i o nw i n d ow lets you re v i ew and listen to annotations on
each individual  move. 

To use the Opening Book Reference:
1. From the Opening Book menu, choose

CHESSMASTER Book Reference.
2. CHESSMASTER displays a loading message

and then opens the Opening Book
Referencewith Mentor.obk, the Master
Opening Book.

3. Use the Opening Moveswindow at the
bottom to review the possible opening moves
and counter moves. The chess board updates
as you select different moves in the tree.

4. When you’re done using the Opening Book
Reference, click the Closeicon (X) in the
upper-right corner.

5. When you view an Opening Book, you see five boxes at the top—Opening,
Moves, Variation, ECO, and Weight —as well as an Opening Moveswindow
at the bottom.

6 .The Opening Move sw i n d ow displays the opening moves of the curre n t
Opening Book.

7. The column titles indicate the move number for each player. For example, “1.”
represents White’s first move, and “1. …” represents Black’s first counter move.
“2.” represents White’s second move, “2. …” represents Black’s second counter
move, and so on.

8 .Cl ick + to display the next column, which l ists all  the possible countermove s
for the Black playe r. As you continue to click + in each column, the
Opening Moves tree begins to expand to show all the possible move lines for
each opening.

9. Once you’ve expanded the Opening Moves tree, you can use either the mouse
or the arrow keys on your keyboard to select the individual moves within the
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THE KIDS’ ROOM
Welcome to the CHESSMASTER 9000 Kids’ R oom, the one room that is
specifically designed just for kids. It’s the one-stop place where kids of all ages
can enjoy the game of chess without having to enter any of the other
CHESSMASTER rooms. In the Kids’ Room you can do a little of everything
that CHESSMASTER 9000 has to offer. You can learn chess basics; you can
practice what you’ve learned using the simplified chess drills; you can play chess
against computerized kid-like opponents; and you can earn Master Class points
for the lessons you complete and the opponents you beat. So, let the
CHESSMASTER 9000 Kids’ Room turn you into the chess player that you’ve
always dreamed you’d be!

§ Choosing Your Board and Chess Set
One way to make chess even more fun is to pick a chessboard and chess pieces
you like.

To choose your Board and Chess Set:
1. Cl ick on Chess Se t sin the Sh o rt c u t sw i n d ow.

2. Scroll through the list of chessboards and
click on one to pick it.

3. Choose pieces to go with the board from the
window below it.

4. Click on OK to save your choices.

§ Learning to Play
After you’ve picked out a chess set, the best place to start is  the tutorials. These
tutorials were created specifically to help you
learn the game of chess quickly and improve
your playing skills.

To select and run a tutorial:
1. Cl ick L e a rn to Pl a y in the Sh o rt c u t sw i n d ow.
2. Click + and - to expand and collapse the

tutorial topics.
3. Select the tutorial you want, and then click

O K. CH ESSMASTER starts the tutorial
you selected.

4 .Read, listen, and watch the first page of the
tutorial , and then click Ne x tto go to the next page.

5. If the tutorial asks you a question, click the appropriate answer, highlight a
square, or make a move on the board, as instructed.

6. Click Cancelto quit a tutorial.

8. Continue this process to specify the entire movement line for the first opening.

9. To build your Opening Moves tree, create a second countermove to the first
opening move by selecting the first opening move in the tree. This returns the
chessboard to that position, so that you can start building the moves line for
the next possible counter move. (Note that the chessboard is like a mirror of
the Opening Moves tree.)

10. Repeat steps 5 through 9 until you specify all the possible move lines for your
first opening.

11. Continue this process to complete your Opening Book. As your tree expands
to the left, a hierarchy develops that includes “parent” moves, “children”
moves, and “sibling” moves. (“Sibling” moves are moves that appear in the
same column and share the same “parent”.) You can use the mouse or the
arrow keys to select individual moves in the hierarchical tree, so you can
modify or delete them.

12. As you create your new opening book, re v i ew the considerations outlined in
the next section. They show you how you can delete a move, save the
c u r rent opening book, clear the Opening Book in case you want to start
over again, base a new Opening Book on an existing one, and edi t an
existing Opening Book.

13. To close the Opening Book, click the Closeicon (X) in the upper-right corner.
14. CHESSMASTER 9000 will ask if you want to save the opening book. Click

Yesor No.

15. If you want to base a new opening book on an existing opening book (or you
want to simply edit an existing opening book), you can load the one you want
by choosing Opening Book -> Load Opening Book from the File menu.
This lets you can choose an Opening Book in CHESSMASTER’s .obk format. 

16. Click Loadto modify the selected .obk file. If an Opening Book already exists
in the Opening Book dialog, and you haven’t saved it, CHESSMASTER 9000
prompts you to save it. You can then edit the existing Opening Book, using
the information in the previous sections.

1 7 .Choosing Im p o rt PGN File from the Fi l e menu lets you load a game in PGN
format into the Opening Book Ed i t o r. You can set the criteria by which PGN
files of games are imported, including gambits, Queen moves, pawn moves, side
to move, wins/losses/draws, length of the game, frequency of captures, and
depth. Or, you can simply import a PGN game with CHESSMASTER’s
default settings.
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4 . Select the opponent you want to play, then click O K. The name of the
opponent you picked appears in the Top opponent box of Set Up Game De t a i l s .

5. You can also play a human playe r, like your bro t h e r, your sister, your pare n t ,
or a friend.

6. To pick a human player as your opponent, leave the Humanbutton selected
and type his/her name into the box. You and your opponent will have to take
turns at the computer to play the game.

Setting the Time
The amount of time you give yourself and your opponent to complete a game
(or a move) is very important in the game of chess. In the Kids’ Room, you have
all the time you want to make your moves in an UnratedPractice game. If you
want to set the time to something different, see “Selecting a Time Control” in
the “Game Room” section.

Choosing Your Color and Switching Sides
CHESSMASTER automatically makes you the Bottom player with White chess
pieces. However, you can change the side you play on, as well as the color of
your pieces. To be Black instead, click the Bottom Computerbutton and choose
your opponent again. You can click the Rotate Board button to switch whether
Black or White is on top.

Starting the Game
1. After you’ve picked your opponent and picked which

side you’re playing, click OK to start the game.
2. A game begins as soon as you or your opponent makes

the first move. If you areWhite, you need to make the
first move. If your opponent is White, you must wait
until your opponent moves.

3 . You can move pieces using the mouse by cl icking and
dragging. CHESSMASTER re c o rds each move yo u
and your opponent make during a game in the Ga m e
St a t u sw i n d ow. 

§ To move a piece on the chessboard:
1. Place the pointer over the chessboard. The pointer changes to a hand.
2. Click the piece you want to move and hold down the mouse button to drag it

to its destination square. The hand grabs the piece as you drag it.
3. If you make a wrong move CHESSMASTER returns the piece to its original

square, and CHESSMASTER tells you why the move is wrong.
4. If you make a mistake and you’re playing an Unratedgame, choose Takeback

Movefrom the Actions menu. (This option is not available if you’re playing a
rated game.)

Note: If you’re having difficulty grabbing a chess piece, make sure the index finger of
the hand is inside the square of the piece you want to move.

§ QuickStart!
If you want to jump right in and play chess, simply click on the QuickStart!
button, and CHESSMASTER 9000 will set up a game for you, based on your
current chess rating. If you don’t yet have a rating, CHESSMASTER 9000 will
choose your opponent, based on your rating choice when you created your user.

§ Working on Drills
The Kids’ Room provides some chess drills you can use to improve your game.

To select and run a drill:
1. Click on Drills in the Shortcutswindow.
2. Click + and - signs to expand and collapse the drill list.

3. Select the drill you want, and then click OK.
4. Try to solve the chess puzzle by moving the pieces. If you move a piece to the

wrong spot, it will pop back to where it started. If you do the problem right,
the next puzzle appears.

5. There are instructions that tell you how to do each exercise. They also show
how long you’ve been trying to solve the current problem.

6. If you can’t figure it out, click Skip to skip the current drill and move on to
the next one, or click Cancelto cancel the drill. 

7.When you finish the drill, the Drill Records tell you how well you did. You can
only have your time added to the Drill Records if you correctly answer every
drill question.

8. Click OK to close the Drill.

§ Playing a Practice Game
If you want to play a practice game, where you can get advice and help from the
CHESSMASTER and do things such as take back your moves, you’ll want to
play an Unratedgame.

Choosing an Opponent
The Kids’ Room provides some computer opponents you can choose from. Each
computer opponent comes with a picture and some text you can read to learn
about the opponent.

To choose an opponent for an Unrated game:
1. Click Play a Gamein the Shortcutswindow.

You areWhite (on bottom), and your
opponent is Black (on top).

2. Click the Computerbutton next to the Top
opponent box, and then click Personality.

3. Scroll through the list to view the available
opponents. Click on the I nfo tab to read
about your opponent.
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Master Class points by completing tutorials,
drills, and Josh games. You can also earn them
w h e n e ver you beat a new opponent in a Ra t e d
game. To see how many Master Class points
yo u’ve earned, use the Pl a yer Pro g re s sw i n d ow.
The Pl a yer Pro g re s sw i n d ow lets you track
your pro g ress and get rew a rded with a
c e rti ficate when you earn the re q u i red number
of Master Class points.

To use the Player Progress window:
1. Click on Progressin the Shortcutswindow.

2. Look at the number of Master Class points that you’ve earned for each
opponent you beat and for the tutorials, drills and Josh games you completed.

3. When you’ve earned the required number of Master Class points, click the
button to print your Master Class certificate.

§ Using Quick Hints
A t any time in a Practice Game, you can ask the CHESSMASTER to give you a
suggestion.

To get a quick hint:
1. Click on Quick Hint in the Shortcutswindow.
2. CHESSMASTER will recommend a move. Select Yesto make that move or

No to refuse the move and return to the game.

Saving and Opening Games
The Kids’ Room lets you save the game you are playing, whether you finished it
or not. The first step to studying your game is to save as many of your games
against as many different opponents as possible. After you save a game, you can
open it at any time and examine it move by move. This will help you learn what
your strengths are, as well as what you need to improve on as a chess player. For
step-by-step procedures on how to save and open chess games, see “Saving and
Opening Games” in the “Game Room” section.

§ Learn from IM Josh Waitzkin
One of the best ways to learn chess is to study with a master-level player.
CHESSMASTER 9000 offers you the next-best thing in the Kids’ R oom, by
letting you play through games of International Master Josh Waitzkin. As Josh
talks about each game, the moves he played are displayed on the chessboard.
Sometimes, Josh discusses other moves that he or his opponent might have
played, and these are shown on the board, too. By following Josh’s games, you
can become a better chess player.

§ Using the Actions Menu
The Kids’ Room provides several features that give you more control over your
game. These features are located in the A ctions menu, and they allow you to do
things like:
• Take back a move.
• Force your computer opponent to move when it’s taking too long.

• Wake up your computer opponent when certain actions confuse it or interrupt
its thinking.

• Pause a game for a quick break.
• Temporarily quit (or adjourn) a game so you can continue it later.
• Offer a draw when it seems unlikely that you or your opponent can win.
• Resign from a game when it seems unlikely that you will win.
These options are described in more detail in the section on the “Game Room.” 

Playing a Real Rated Game
In a real game, the winner gets a rating increase, and the loser loses rating points.
To see your overall rating, choose Progressfrom the Shortcutswindow. For
detailed information on the Player Progresswindow, see “Using the Player
Progress Window” below. You set up a Ratedgame much like you set up a
Practice game.
1. From the Shortcuts window choose Play a Rated Game
2. Choose your opponent, select a time control, and choose your piece color, just

like you did in a Practice Game. 

3. You can choose Play Random Colorto have CHESSMASTER choose your
piece color for you.

4. Also, when you’re picking your opponent, on the upper left you can see what
will happen to your rating if you win, lose, or draw against that opponent. If
you play opponents that aren’t very good and you lose, your rating goes down.
If you play opponents with a higher rating than you and you win, your rating
goes up!

§ Player Progress & Master Class Points
Have you ever seen the movie Searching for Bobby Fischer?Well, if you have, then
you know all about Master Class points and Master Class certificates. Just like in
the movie, the Kids’ Room lets you earn Master
Class points, which are similar to gold stars that
you often get in school when you do well on a
test, or when you help the teacher clean the
chalkboard after class.

If you earn enough Master Class points, the
K i d s’ Room rew a rds you w i th a Master Class
c e rti ficate, complete with your name and the
official signature of Josh Wai tzkin! You can earn
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the ECO number (or opening code) in the current chess notation.

Rearranging the Game List
The columns in the Game List show the game number, the ECO code of the
game opening, the players and their colors, the game results, and the game event.
By default, the games are listed in ascending order by game number.

You can sort games by ECO code, player name, game result, and event by
clicking the appropriate column title. ECO codes appear in alphanumeric order,
player names and events appear alphabetically, and game results appear in
ascending numerical order. You can also rearrange and change the columns that
appear in the Game Listwindow. For example, you can rearrange the order in
which the columns appear, delete existing columns, or add new ones.

To rearrange the order in which the columns appear:
Click the column title and drag it in front of or behind another column.

To delete and add existing columns:
1. From the Preferencesmenu, choose Column Setup.

2 . To add a column, select the column you want from the Avai lable Columnsl i s t ,
and then click the - > button. (To add all available columns, click the => b u t t o n . )

3. To delete a column, select it in the Selected Columnslist, and click the <-
button. (To delete all displayed columns, click the <= button.)

4. To use the default configuration, click D efault.
5. Click OK to assign the column settings.

Using the Opening Moves Window
The Opening Moveswindow (at the bottom of
the Database Room) displays the opening moves
for the game selected in the Game Listwindow.
The moves highlighted in red indicate the moves
that were played in the currently selected game;
all other moves in the opening tree are displayed
in white. The column titles indicate the move
number for each player. For example, “1.”
represents White’s first move, and “1. …”
represents Black’s first move. “2.” Represents
White’s second move, and “2. …” represents
Black’s second move. 
1. Use the ar row buttons on the right to move through the tree of moves for

the opening.
2. Select Key Modein the Preferencesdrop-down menu to view the games that

have gone out of the opening book after the selected position. The Game List
window updates to reflect the corresponding games.

3. To view a specific game, select it in the list, and click the Movestab.

4. To return to the database games, click Key Modeagain. 

To Play Through a Josh Waitzkin Game:
1. Click on the Josh button.

2. Select the game you want, and then click OK.
3. Josh talks about and illustrates each move in the list.
4. Pausestops the IVA in its current state so that when you play it again, it starts

where it left off.
5. Stop rewinds the game to the beginning of the current annotation.
6. Use the VCR buttons to step through the moves one-by-one.
7. Click the Close(X) icon in the upper-right corner to leave the game.

THE DATABASE ROOM
Welcome to the CHESSMASTER 9000 Database Room, which contains a huge
database of over 500,000 chess games, including Grandmaster-level games from
2001 and 2002. When you’re in the Database Room, you can perform simple or
complex searches for chess games played throughout history, and even create your
own database of games. You can use the database to view detailed information on
each game, including the move list, game results, events, and player ratings. You
can also analyze game openings, add and delete games, export games and search
for games by opening line, board position, or multiple search criteria.
Our tour of the Database Room is broken down into:
• Display Game Details
• Search for Games

• Working with Databases

Note: If this is your first time using the Database Room, you should consider
reviewing “Defining Your Room Environment,” so that you can set up the Database
Room chess sets and windows as you like.

Displaying Game Details
The Database Room consists of a menu bar and five tabs: Move s, Game In f o,
Key In f o, Data Qu e ry, and Position Se a rc h. Each tab is divided into thre e
w i n d ows. The top window changes according to the tab you select. The middle
w i n d ow, called the Game List w i n d ow, appears the same for all tabs. It lists all the
games in the current database. (The CHESSM ASTER 9000 game database is the
default.) The bottom window, called the Opening Move s w i n d ow, also appears
the same for all tabs. It shows a tree of possible moves for the opening selected in
the Game List w i n d ow.

To view game information:
1. Click the Game Info tab or choose Game Info from the View menu.
2. You will see the following information: Game title, layer information, player

ratings, elapsed time, event name, the site location, the annotator, the round
number in which the game was completed, the date the game was played, and
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Searching for Games
CHESSMASTER lets you search for games by setting up a specific board
position, or by performing queries that define game criteria and game parameters.
Before you perform a search, make sure the CHESSMASTER database is open.
If it’s not, use Open Databasein the File menu to open it.
The CHESSMASTER database lets you define queries using a wide range of
game parameters. For example, you can search by opening moves, players, events,
dates, sites, rounds, ratings, and so on.

To perform a search:
1. Click the Data Query tab, or choose Query from the View menu.
2. Using the five drop-down lists, specify up to five game parameters by which

you want to search. You can choose from 22 different parameters, or specify a
given parameter as <empty>. The default five parameters areWhite Player,
Black Player, Event, Date, and Site. You can do this by opening all moves that
are highlighted in red until you reach the last one in the opening tree.

3. You can type more specific search criteria in the corresponding boxes under
each game parameter. For example, to find a game with a specific Black Player,
type the name of the player under the Black Player parameter.

4. The more rows you fill, the more specific your search. For example, if you
specify Moves as one of the five game parameters, and you specify <40, then
CHESSMASTER returns all games that have less than 40 moves for BOTH
players. You can right-click on any of the blank edit boxes to see some hints on
how to fill in these boxes for each search parameter. Continuing this example,
if you added a name to the Black Player column, CHESSMASTER returns the
games with less than 40 moves that have the specified Black player, thus
narrowing the results.

5. From the Preferencesmenu, choose Show Deleted Gamesto include games
(in the search) that are marked for deletion.

6. Click Search to perform the search. The games that match the criteria appear
in the Game Listwindow.

7 . Click Stop or choose Cancel Qu e ry f rom the Qu e ry menu to cancel  the searc h .
8 .Cl ick C l e a ror choose New Qu e ry f rom the Qu e ry menu, to clear the row s

and columns and display the default game parameters, so you can define a
n ew searc h .

9. CHESSMASTER lets you save the search queries that you define, so you can
use them again. For complex queries, this can save you a lot of time.

To save the current search query:
1. From the Query menu, choose Save Query.

2. In the Query Name box, type a name for the query, and then click Save(or
click Cancelto cancel the operation).

Opening the Move List
The Movestab displays a move list and chessboard for the currently selected
game in the Game Listwindow. The move list always uses Algebraic notation.
You can use it to view the corresponding moves on the chessboard.

Note: If you are unfamiliar with chess notation, we strongly suggest that you use the
Tutorials in the Classroom to learn about the various methods of re c o rding chess games.

To use the move list for the current game:
1. Click the Movestab, or choose Movesfrom the View menu.
2 . Use the VC Rbuttons to scroll through each move, or click the moves in the list.
3. The mini-chessboard updates to reflect the current move.
4. Check or clear Show Annotationsand Show Variationsto hide and display

move annotations and any interesting move variations stored for that game.

To view information about an opening:
1. In the Game Listwindow, select a game that uses the opening you want to

view. The opening appears in the Opening Moveswindow.
2 . In the Opening M ove sw i n d ow, select the last move that defines the

opening path.
3. Click the Key Info tab or choose Key Info from the View menu.
4. The Key Infotab displays the following information:

• The code, name, and any remark for the selected opening.
• The Subkeysfields show the number of possible moves after the current key

move, as well as the total possible moves from the selected position in the
opening. They also show the number of games one move after the current
selected key move, and the number of all games in the database in all
Subkeys below the current selected key move. 

• The Subgamesfields show the number of games in the database that have
gone out of the opening book after the selected position, and the number of
database games that have used the moves up to the selected position in the
opening book.

• The Result fields display the number of games in the database that have
won, drawn, and lost with the same opening.

• The Average ELO fields display the average rating of the players who played
games using the same opening path.

5. To view the games that have gone out of the opening book after the selected
position, click Key Modein the Preferencesmenu. The Game Listwindow
updates to reflect the corresponding games.

6. To view a specific game, select it in the list, and click the Movestab.
7. To return to the database games, click Key Modeagain.
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Creating and Opening Databases
To organize some of your own games, you can create a new database to store
them. When you create a new database, you start from scratch, and then import
the games you want to include.

To create a new database:
1. From the File menu, choose New Database.
2. In the Save In box, keep Database Files as the location for the new database.

3 . In the Sa ve as Ty p eb ox, accept the default Database File (* .TBG) as the file type.
(You can import or add PGN files to the CHESSMASTER database as we l l . )

4. In the File Namebox, type a name for the database.
5 .Cl ick Sa ve to c reate the new database. A message appears indicating that a

n ew database is being created, then the Database Room displays an empty
Game L ist w i n d ow.

6. Add the games you want to your new database.

To open an existing database:
1. From the File menu, choose Open Database.
2. Use the Look In box to specify the folder that contains the database you want

to open.
3. In the File of Type box, make sure Database File (*.TBG) is displayed.
4. In the Open As box, make sure Auto or Database is displayed.

5. Select the database you want, and then click Load.
6. CHESSMASTER displays the corresponding games in the Game Listwindow.

Optimizing, Deleting, and Closing Databases
CHESSMASTER lets you optimize the database by permanently deleting games
you have marked for deletion and indexing new games that you have added. This
considerably improves the search and indexing performance of the database. If
you make extensive changes to an existing database, or create a new one, it’s a
good idea to run the optimization feature.

To optimize a database:
1. Open the database you want to optimize.
2. From the File menu, choose Optimize Database.
3. Make sure a check mark appears next to Clean Database and Create Index

Filesto permanently delete games that are marked for deletion and to index
the games you added.

4. Click OK to optimize the database and enhance its performance.

To delete a database:
1. Open the database you want to delete.
2. From the File menu, choose Delete Database. CHESSMASTER asks you to

confirm the deletion.

To open a query:
1. From the Query menu, choose Load Query.

2. Select the query you want to open, and then click Load.
3. CHESSMASTER opens the selected query, and the fields on the Data Query

tab are populated accordingly.
4. To delete a query, select the query you want to delete from either the Load

Query or Save Query dialog, and then click Delete. CHESSMASTER asks
you to confirm the delete. Click Yes.

To search for games by board position:
1 . Click the Position Se a rc h tab or choose Posi tion Se a rc h f rom the V i e w m e n u .
2. Set up the board position by which you want to search using one or more of

the following methods:
• To use all or most of the pieces, click Initial Position to place the white and

black pieces on the chessboard in their starting positions, and then drag the
pieces to the appropriate squares.

• To set up a position that uses few pieces, click Clear Position to start with
an empty board, and then position the pieces by clicking the chess piece
buttons you want to use, followed by their destination squares. Once the
pieces are on the board, you can drag them anywhere you want.

• To use the board position from another CHESSMASTER room, choose
Copy Game From in the Edit menu, and then from the cascading menu,
choose the room from which you want copy the board position. Then click
Copy from Moves Tab.

• To use a board position from a game in the database, use the Movestab to
select the game you want and to display the desired board position, and
then return to the Position Search tab and click Copy from MovesTab.
For more information on the Movestab, see “Opening the Move List.”

• To use the selected position in the Opening Move sw i n d ow, cl ick C o p y
Key Po s i t i o n.

• Check the White to Movecheck box if it’s White’s turn to move next. Clear
it if it ’s Black’s turn to move next.

Working with Databases
In addition to viewing and searching for games in the CHESSMASTER
database, the Database Room also lets you:
• Create and open new databases.
• Import and export games to and from databases.
• Mark games for deletion so that CHESSMASTER ignores them during a

search. This does not delete these games permanently from a database.
• Optimize, delete, and close databases.
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To mark a game for deletion:
1. Open the database that contains the game you want to mark for deletion.

2. From the Game Listwindow, select the game(s) you want to mark. Use Ctrl
or Shift to select multiple games.

3. From the Edit menu, select Delete Selected Games. This will mark your
selected games as deleted.

THE CHESSMASTER LIVE ROOM
Welcome to the CMLive Room, the place where you can play chess with other
CHESSMASTER 9000 owners over the Internet on Ubi.com. You can also
communicate or chat with other remote players, and display information on
players who are currently connected to Ubi.com. 

Note: Playing an Internet game requires a 56.6 Kbps or faster modem/direct
connection.

§ Starting a CMLive session on Ubi.com
1. There are three ways to start a session and play a game over Ubi.com:

a. Click on the Ubi.com button in the CMLive room.

b. Or select CHESSMASTER 9000 -> Play CHESSMASTER 9000 on
Ubi.comfrom the Windows Start menu.

c. Or you can click on the Play on Ubi.com button on the CHESSMASTER
9000 Welcome Screen, which comes up when you insert your
CHESSMASTER 9000 CD.

2. When you connect to Ubi.com, go to the
CHESSMASTER area, where you will find a
number of games for you to join. Or, you can
create a game yourself. See “Challenging
Another Player” below.

3. When you start up a session on Ubi.com, it
closes out everything else running in
CHESSMASTER 9000. So, make sure to
save any other games, databases, or analysis,
you may have in progress.

4 .CHESSMA STER 9000 keeps separate stats for online and solo play. So, if
you want those to be available in the same CHESSMA STER 9000 session,
you want to make sure that your Ubi .com user name and yo u r
CH ESSMASTER 9000 login name are the same.

3. Click OK.

To close the current database
From the File menu, choose Close Database. CHESSMASTER clears the Game
List and Opening Moves windows. Use Open Databasein the File menu to
open another database.

Importing and Exporting Games
You can import saved games in PGN format to any CHESSMASTER 9000
database. This provides a convenient way to organize and categorize your games.

To import a game to a database:
1. Open the database to which you want to import the game using the procedure

outlined above.
2. From the File menu, choose Import Games.
3 .Use the Look In b ox to speci fy the folder that contains the game you want

to import .
4. In the File of Type box, select Portable Game Notation (PGN).
5. In the Open As box, accept Auto, and then click Load.

6. CHESSMASTER adds all games from the PGN file to the Game List
window. If the PGN file has a large number of games, this process may take
several minutes to finish.

To export a game:
1. You can export games from any CHESSMASTER 9000 database to PGN

format. Also, you can export more than one game at a time.

2. Make sure the database that contains the game you want to export is open.
(Use the procedure outlined in the previous section.)

3. From the Game Listwindow, select the game(s) you want to export. Use Ctrl
or Shift to select multiple games.

4. From the File menu, choose Export Selected Games.
5. Use the Save In box to specify where you want to export the game.
6. In the Save as Typebox, accept PGN Game Files.
7. Use the default file name or type a new one in the File Namebox, and then

click Export.

8 . CHESSMASTER exports the file to the specified folder, file type, and file name.

Omitting Games During a Search
CHESSMASTER lets you mark games for deletion so that it doesn’t look for
them during a search. When you mark a game for deletion, a “D” appears next
to the corresponding game name in the Game Listwindow. If you mark a game
for deletion, you can always unmark it so that the database sees it again.
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• If you select Post Challenge, use the Min and Max boxes to specify the
rating range of the person you want to play. Type the minimum rating in
the Min box and the maximum rating in the Maxbox. You can only post
one standing challenge at a time.

• If you select Pl a yer Challenge, choose who want to play from the
Pl a ye r sl i s t .

3. Check or clear Others Can View to indicate whether you want other people
to be able to watch your game.

4. Use the next set of options to specify:
• Whether you want to play a Ratedor Unratedgame.
• Whether Takeback Move(in the Ac t i o n smenu) is allowed. If you speci fy

the game as Ra t e d, Takeback Movewil l be unavailable, just as in any
other Ra t e dgame. 

• The piece color you want to play, White or Black, or you can let
CHESSMASTER randomly assign the colors.

5. Use the last group of options to select a time control for your game. If you
specify the game as Rated, note that Seconds per Moveand Infinite Time
are not available, just as in any other Ratedgame. 

6. Select Enforced Time to end the game within the time you set, or select
Unenforced Time to continue playing the game after it officially ends.
Enforced Time is always activated for a Ratedgame.

7. Select either Post Challengefor a general challenge, or Send Challengeto
challenge a specific player.

8. Check A utopostif you always want your challenge posted.
9. Click OK to accept the settings, or click Closeto cancel the settings. When

you send a challenge to an individual player, the You Are Being Challenged
message appears on that player’s screen.

10. A message on your screen indicates whether the player accepts or declines your
challenge. If the player accepts, the chessboard becomes active.

Accepting a Challenge
You can either accept a challenge that another player sends you, or you can
accept a standing challenge posted by another player. When another Internet
player sends you a challenge, a message appears notifying you of the parameters
of the game.

To accept a challenge from another player:
1. In the You Are Being Challengeddialog, click A cceptand start playing.

Click D eclineif you don’t want to accept.

2. If you areWhite, you must make the first move. If your opponent is White,
you must wait for him or her to make the first move.

3. Standing challenges appear in the Online Information window under
Challenges.

TCP/IP and LAN Play
CHESSMASTER 9000 also supports play over TCP/IP and LAN. 

To start CHESSMASTER Live using TCP/IP:
1. Click the TCP/IPbutton in the CMLive Room.
2. Choose either to host a new Internet game or join an existing game.
3. Do one of the following:

• To hosta session, type a name in the Game Namebox, click Host and then
wait for your opponent to join you.

• To join a session, type the IP address (in the Host Namebox ) of the player
who’s hosting the game you want to join, and then click Join.

4. CHESSMASTER connects you to the remote host, so you can start playing
over the Internet.

5. See the CMLive Help for step-by-step instructions on all the CMLive features.

To start CMLive using a LAN:
1. Click the LAN button. CHESSMASTER prompts you to specify whether you

want to host a new LAN game or join an existing LAN game.
2. Do one of the following:

• To hosta session, type a name in the Game Namebox, click Host, and
then wait for your opponent to join you.

• To join a session, select the game you want to join from the Active Games
list, and then click Join. (The Active Games list displays all the games
currently being hosted on the local network.) CHESSMASTER connects
you to the hosted game, so you can start playing over the Internet.

3. CMLiv e does not support direct-connect modem play.

Challenging Another Player
To play an online game over the Internet, you need to challenge or accept a
challenge by another Internet player. When you challenge another Internet
player, you specify the parameters of the game you want to play and select an
opponent.

To challenge another Internet player:
1 . From the Ga m emenu, choose C h a l l e n g e.

You can ei ther challenge a part i c u l a r
individual or post a standing challenge to all
p l a yers in your onl ine session. You can only
challenge players not currently  playing a game.

2 .Select Post Chal lengeto post a standing
chal lenge to all players in your online
session, or Pl a yer  Challengeto chal lenge a
speci fic person.
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specific individuals, select the names in the list. Use the Ctrl key to select
multiple player names.

5 . Send Op t i o n slets you send a message. First select a player from the Pl a ye r
List. In the Message to Se n db ox, type the message you want to send, and
then click Se n d.

6. Ignore Options lets you ignore (or not receive) challenges and messages from
other players. Check or clear Ignore Challenges and Ignore Shouts to turn
ignore off or on respectively.

7. To ignore individual players, right-click the player’s name in the Player List or
in the Messagewindow, and choose Ignore. To acknowledge them again,
right-click the names and choose Un-ignore.

§ Setting Up CMLive Sounds
CHESSMASTER 9000 provides a few settings that let you take advantage of the
sounds that CHESSMASTER plays when someone from CHESSMASTER
LIVE logs on, sends you a message, or challenges you to a game. When you use
these settings, CMLive must be running.

To turn the CMLive sounds on and off:
1. From the Preferencesmenu, choose Sound.
2. Click the Effectstab.
3 .Check the sounds you want on, clear the sounds you want off, and then

click O K.
• Window Closeproduces a sound whenever you close the CHESSMASTER

window or exit.
• Buddy Loginproduces a sound and a message whenever someone from

CMLive logs on.
• Tell Chatproduces a sound and a message whenever someone from

CMLive sends you a message.

• Game Challengeproduces a sound and a message whenever someone wants
to challenge you to a game in the CMLive Room.

4. To turn window and CMLive sounds on and off, check the sounds you want
on, clear the sounds you want off, and then click OK.

Using the Online Information Window
The Online Information window in the CMLive Room lets you view
information about the current Internet players, the games in progress, and the
posted challenges.

To use the Online Information window:
From the Windowsmenu, choose Online Information. The chess piece next
to the menu option indicates that it’s open. Choose Online Informationagain
to close it. The different areas of the Online Information window and how to
use them are described below.

To accept a standing challenge:
1. If the Online Informationwindow isn’t open, choose Online Information

from the Windowsmenu.

2. Right-click the challenge in the list, and then click A ccept Challenge. If you
do not meet the rating requirements of a challenge, or you have chosen to
ignore the challenger, the challenge is grayed-out in the list. For more detailed
information, see the “Using the Online Information Window” section.

§ Understanding the Rating System
When you play a CMLive game over Ubi.com, the results of that game affect
your online chess ratings of you and your opponent. CHESSMASTER 9000
records a separate rating for your online rating and your rating in the
Tournament Room. When playing on Ubi.com, CHESSMASTER 9000 keeps a
number of statistics on your games, including your record with Black and White
pieces, how you have performed against individual opponents, in blitz play, and
so forth.

Note: Any games played via TCP/IP and LAN neither affect your online rating, nor
do they keep your online statistics, as Ubi.com play does.

Using the Chat Window
CHESSMASTER provides a Chatwindow in the CMLive Room that lets you
send and receive messages from other CMLive players, as well as ignore messages
and challenges from other players.

To use the Chat window:
1. From the Windowsmenu, choose Chat. The chess piece next to the menu

option indicates that it’s open. Choose Chatagain to close it. The different
areas of the Chatwindow and how to use them are described below.

2. Message Window–Displays the messages you send and receive, preceded by
the name of the player who sent the message and the message type. You can
send and receive the following types of messages:
Shouts – Messages sent to all players in the session. 
Says– Messages sent to more than one, but not all, players in the session.
Tells– Messages sent to you from another player.
Thinks – Messages sent to yourself, such as reminders.

3. Right-click on a player name preceding a message in the Messagewindow to
do any of the following:

a. View a player profile.
b. Ignore a player.
c. Undoan ignore.
d. Challengea player.

4. Player List displays all the people in the selected channel. To send a message
to all players in the channel, choose Select Everyone. To send a message to
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The Challenges List
In the Online Information window, click Challengesto open the Challenges
List. The Challenges Listdisplays all the standing challenges posted by the
current online players, which you can accept. Posted challenges include the
names and ratings of the challengers, the types of games they want to play
(bullet, blitz, or standard), the time controls they want to use, the piece color
they want you to play, and the rating ranges for their opponents. A number after
a game rating indicates a provisional rating, meaning the player has played 20 or
fewer games in that category. The number indicates the number of provisional
games that have been played in that category.

If you do not meet the rating requirements of a challenge, or you have chosen to
ignore the challenger, the challenge is grayed-out in the list. The Challenges List
arranges information in columns, according to the player names and the
guidelines of the challenge. To sort the lists according to the information in each
column, select the appropriate column heading. For example, select the Rating
column heading to sort the list numerically by each challenger’s rating.
To accept a posted challenge, double-click the challenge, or right-click it and
choose Accept Challenge. To edit one of your own standing challenges, you
must remove it, and then post a new one.

The Players List
In the Online Informationwindow, click Playersto open the Players List. The
Players Listdisplays the names of all the online players, their playing status, and
their bullet, blitz, and standard game ratings. (In a bullet game, the game time is
set to three minutes or less; in a blitz game, the game time is over three minutes
but less than 15; in a standard game, the game time is set to 15 minutes or
more.) A number after a game rating indicates a provisional rating, meaning that
the player has played 20 or fewer games in that category. The number indicates
the number of provisional games that have been played in that category.
The Players Listarranges information in columns, according to the player
names, playing status, and rating for each game type. To sort the lists according
to the information in each column, select the appropriate column heading. For
example, select the Nickname column heading to sort the list alphabetically by
player name. 
You can right-click a player’s name, and then choose an option to:
• View a player profile.

• Challenge a player, if he or she is not playing a game.
• View a player’s game, if he or she is playing a game.
• Ignore or acknowledge a player.
To sort the lists according to the information in each column, select the
appropriate column heading. For example, select the White Player column
heading to sort the list alphabetically by the
white players’ names.
You can right-click a game, and then choose an
option to:
• View the game on the chessboard.
• View the player profile of each player.

You can also double-click a game to view it on
the chessboard.

The Games List
In the Online Information window, click Gamesto open the Games List. The
Games Listshows all the games in progress, the players in each game (with their
piece color and game rating), the type of game being played (bullet, blitz, or
standard), and the time control for each game. A number after a game rating
indicates a provisional rating, meaning that the player has played 20 or fewer
games in that category. The number indicates the number of provisional games
that have been played in that category.
The Games in Progresslist arranges information in columns, according to the
player names for each color, each player’s rating, the type of game being played,
and the time controls for the game.
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c. Commandline Parameters—Look at the documentation for the chess
engine to see what, if anything, may be entered into this field.

d. Pondering—Select this option if you want the Winboard engine to think
on its opponent’s turn.

2. Once you have filled out all fields, pressing OK will automatically create the
Winboard engine’s personality. This personality can then be used anywhere
inside CHESSMASTER 9000, just like any other user-created personality.

3 . You can edit any Wi n b o a rd engine personali ty just as you would any other
CH ESSM ASTER 9000 personali ty . Just go to Ga m e - > Set Up Pe r s o n a l i t y
in the Game Room and select the impor ted Wi n b o a rd personal ity to edi t.
You wi ll  then be able to modi fy anything that you typed in when cre a t i n g
the personality.

4. Most Winboard engines will work in CHESSMASTER 9000. However, some
CHESSMASTER 9000 features might not be supported, most likely the
Infinite Time control, Force Move, starting a game from a non-standard
position, and pondering output for the Thinking Lineswindow. In addition,
the output in the Thinking Lineswindow may be in a format specific to that
engine, and not identical to that used by CHESSMASTER.

5. There are two windows for Winboard Engine Output, available only in the
Game Room. There is one window each for White and Black, and, when
opened, they allow you to see all of the communication that is going on
between CHESSMASTER and the Winboard engine that you have imported.
This is useful for getting raw data from an engine that has output that
CHESSMASTER 9000 might not understand and cannot properly display in
one of its other windows. Note that these Output Monitor windows will
ONLY receive data if they are opened, in order to maximize CPU efficiency.
Any time these windows are closed, all data that would normally be sent to
these windows will not be retrievable.

Note: Please note that Winboard support is intended only for advanced users to
experiment with other chess engines within the CHESSMASTER 9000 program. Ubi
Soft cannot give technical support for other chess engines or programs. However, if you
have general questions about this feature, write the CHESSMASTER 9000 team at
www.chessmaster.com

Endgame Databases
If you opt for the complete install option, you can then set up the following
position with CHESSMASTER playing both sides. See how CHESSMASTER
plays the endgame perfectly to achieve a checkmate in 48 moves:

White King on e1
White Bishops on d2 and e2
Black King on e8
Black Knight on d7
White to Move

ADVANCED PLAY OPTIONS IN 
CHESSMASTER 9000

Playing a Blindfold Game
In the Game Room, you can specify in Setup Game Details whether one or both
players play blindfolded—where you must remember moves without seeing them
on screen. In Blindfold chess, the only way for you to make your move is with
the keyboard, and moves must be entered in the currently selected notation.

Playing a Random Game
You may choose a Random opponent from the New Gamemenu. This will select
an appropriate opponent at random for you, according to your current rating.
This option is only available for Ratedand Tournamentgames.

Playing a Hidden Opponent
When you choose to play a Random opponent, you can specify that the
opponent’s identity be hidden from you during the game. This is a great way to
see how you fare against an unknown opponent.

Playing a Game vs. Another Chess Engine
The chess engine in CHESSMASTER 9000 is called The King. However,
CHESSMASTER 9000 supports the Winboard communication standard. This
means, if you own any other freeware or commercial chess program that also uses
the Winboard standard, you can run those programs through CHESSMASTER
and compete against them choosing the Winboard opponent option. 
Once you have downloaded your Winboard chess engine, you should read any
included documentation thoroughly. Many of these engines require files or
settings to be properly dealt with before the engine will work properly. Some of
these settings are called Commandline Parameters, which you will have to
supply to CHESSMASTER when you import the engine.

To import a Winboard engine:
1. Go to the Game Room and select Game -> Import Winboard Engine. Fill

out the three fields you see there:
a. Name—Choose any name for your personality…as long as it can be made

into a legal Windows filename, and a personality of that same name doesn't
already exist. 

b. Filename of the Winboard engine program—This filename almost always
has an EXE extension, and the full path to the file is required. So, if you
have downloaded Crafty, and have placed the Crafty program in the
C:\Crafty folder on your hard drive, you will need to enter
C:\Crafty\Crafty.exe assuming that the name of the program is Crafty.exe.
To assist you in entering the proper path and filename, you can also press
the Browsebutton to search for the data. 
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PROOF OF PURCHASE

CHESSMASTER® 9000

Thanks to all the knowledgeable posters at www.TalkChess.com and the many
chess club members and other amateurs whose assistance was invaluable.

MPEG Layer-3 playback supplied with the Miles Sound System from RAD
Game Tools Inc.
MPEG Layer-3 audio compression technology licensed by Franhofer IIS and
THOMSON multimedia

Uses Bink Video Technology
Copyright © 1991-2002

By RAD Game Tools, Inc.

CHESSMASTER 9000 © 2002 Ubi Soft Entertainment.
CHESSMASTER® is a registered trademark of Ubi Soft Entertainment. 

About the Chess Engine

The King
In 1987, Johan de Koning (de Koning is Dutch for “The King”) started writing
chess programs. From its early beginnings using a 69000 processor, the King has
been rewritten for today’s much more powerful microprocessors, but has always
shown an attractive and enterprising playing style. Unlike many other computer
programs, The King actively seeks attacking possibilities and is ready to sacrifice
material not only on tactical, but also on positional grounds. 
§ Enjoy your copy of CHESSMASTER 9000!
Make sure to check:
• The CHESSMASTER 9000 READ.ME document to see any late-breaking

changes to the program
• www.chessmaster.com for the latest updates, news, and downloads
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UBI SOFT LICENSE AGREEMENT
SINGLE-USER PRODUCTS
THIS IS A LEGAL AGREEMENT BETWEEN YOU (EITHER AN INDIVIDUAL OR AN ENTITY) AND
UBI SOFT ENTERTAINMENT S.A. AND ITS SUBSIDIARIES AND AFFILIATES (“UBI SOFT”). THIS
AGREEMENT IS GOVERNED BY THE INTERNAL SUBSTANTIVE LA WS OF THE STATE OF
CALIFORNIA (AND NOT BY THE 1980 UNITED NATIONS CONVENTION ON CONTRACTS FOR
THE INTERNATIONAL SALE OF GOODS, AS AMENDED). BY INSTALLING OR USING THE
SOFTWARE, YOU AGREE TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT
AGREE TO THE TERMS OF THIS AGREEMENT, REMOVE THE PRODUCT FROM YOUR HARD
DRIVE AND PERMANENTLY ERASE ALL COPIES OF THE PRODUCT. IF YOU ARE THE ORIGINAL
INSTALLER OF THE SOFTWARE YOU MA Y PROMPTLY RETURN THE SOFTWARE (INCLUDING
PRINTED MATERIALS) WITH PROOF OF PURCHASE TO THE PLACE WHERE IT WAS
PURCHASED FOR A FULL REFUND OF THE AMOUNT PAID.

UBI SOFT SOFTWARE LICENSE
GRANT OF LICENSE. This License Agreement permits you to use one copy of Ubi Soft software (the
“Software”), which may include electronic documentation, on a single computer/workstation. The
Software is “in use” on a computer when it is loaded into the temporary memory (i.e., RAM or Cache)
or installed into permanent memory (e.g., hard disk, CD-ROM drive, or other storage device) of that
computer. This License does not constitute a sale and does not authorize a sale of the Software or
anything created thereby. All intellectual property (including copyright, trademark and patent) in the
Software, including all animations, audio, images, maps, music, photographs, video, and text
incorporated into the Software, are owned by UBI SOFT and its affiliates, suppliers and licensors, and
are protected by United States laws and international treaty provisions. Ubi Soft and its affiliates,
suppliers and licensors retain all rights not expressly granted. You must treat the Software like any
other copyrighted material, except that you may make one copy of the Software solely for backup or
archival purposes. You may transfer your rights under this Agreement on a permanent basis provided
you transfer the license granted by this Agreement, and the Software and all associated printed
materials, and you retain no copies, and the recipient agrees to all of the terms of this Agreement.

• You may not use the software on or over a network or any other transfer device (including the 
Internet) except in a manner using the network and online functions included in the Software, if 
any. Use of the Software on more than one computer constitutes copyright infringement and may 
be punishable by civil fines, criminal penalties, or both.

• You may not rent or lease the Software, but schools and libraries may lend the Software to third
parties provided the Software is in CD format and each end user is given a copy of this License 
Agreement which will govern the use of such Software.

• You may not modify, translate, reverse engineer, decompile, or disassemble the Software, except 
to the extent that this restriction is expressly prohibited by applicable law.

• You may not remove any proprietary notices or labels in the Software.

• You may not copy the printed materials accompanying the Software or distribute printed copies of 
any user documentation provided in electronic format.

• You may not publicly perform or publicly display the Software.

The restrictions contained herein apply equally to hybrid CD-ROMs which may contain multiple
versions of the Software for use on different operating systems. Regardless of the type of media you
receive, you may use only the portion appropriate for your single-user computer/workstation. In the
event you fail to comply with any of the terms or conditions of this license, your rights to use the
Software will end, you shall stop using the Software, remove the Software from your computer, and
permanently erase all copies of the Software. You may not export or reexport the Software or any
underlying information or technology except in full compliance with all United States and other
applicable laws and regulations.
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